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IMPORTANT SAFETY INSTRUCTIONS 
 

 

The lightning flash with arrowhead symbol within an equilateral triangle is 
intended to alert the user to the presence of un-insulated, dangerous voltage 
within the product’s enclosure that may be of sufficient magnitude to constitute 
a risk of electric shock to persons. 

 

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (i.e.: servicing) 
instructions in the literature accompanying the product. 

 
• Read these instructions. 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Don’t use this apparatus near water. 
• Clean only with a dry cloth. 
• Don’t block any ventilation openings.   
• Install in accordance with the manufacturer’s instructions. 
• Don’t install near any heat sources such as radiators, heat registers, stoves, or other 

apparatuses (including amplifiers) that produce heat. 
• Don’t defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has 

two blades with one wider than other.  A grounding-type plug has two blades and a third 
grounding prong.  The wide blade or third prong is provided for your safety.  If the plug provided 
does not fit into your outlet, consult an electrician to replace the obsolete outlet. 

• Protect the power cord from being walked on or pinched, particularly at plugs, convenience 
receptacles, and the point where they exit from the apparatus. 

• Only use attachments/accessories specified by the manufacturer 
• Unplug this apparatus during lightning storms, or when unused for long periods of time. 
• Refer all servicing to qualified service personnel.  Servicing is required when the apparatus has 

been damaged in any way, such as damage to the power-supply cord or plug, contact with 
liquid (or any object small enough to enter the apparatus), exposure to rain or moisture, drop 
damage, or upon experiencing any abnormal operation. 

 

WARNING: 
TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS 
APPARATUS TO RAIN OR MOISTURE 

WARNING: 
DO NOT EXPOSE THIS EQUIPMENT TO DRIPPING OR SPLASHING AND ENSURE THAT NO 
OBJECTS FILLED WITH LIQUIDS, SUCH AS VASES, ARE PLACED ON THE EQUIPMENT 

WARNING:  
TO COMPLETELY DISCONNECT THIS EQUIPMENT FROM THE AC MAINS, DISCONNECT 
THE POWER SUPPLY CORD PLUG FROM THE AC RECEPTACLE 

WARNING:  
THE MAINS PLUG OF THE POWER SUPPLY CORD SHALL REMAIN READILY OPERABLE 



 

WARNING 
 

 

Never look directly into an optical fiber. Irreversible eye damage can occur in a 
matter of milliseconds. 

 



 

INFORMATION TO USERS IN EUROPE 
 

NOTE 
 

This equipment with the CE marking complies with both the EMC Directive (2004/108/EC) and the Low Voltage 
Directive (2006/95/EC) issued by the Commission of the European Community. 
 
Compliance with these directives implies conformity to the following European standards: 

• EN60065 Product Safety 
• EN55103-1 Electromagnetic Interference Class A (Emission) 
• EN55103-2 Electromagnetic Susceptibility (Immunity) 

 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to the 
European Union EMC directive.  These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment.  This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications.  Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the interference at his own expense. 
 

 
INFORMATION TO USERS IN THE U.S.A. 

NOTE 
 

FCC CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 
of the FCC Rules.  These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment.  This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications.  Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 
 

WARNING 
 

Changes or modifications not expressly approved by Evertz Microsystems Ltd. could void the user’s authority to 
operate the equipment.  Use of unshielded plugs or cables may cause radiation interference.  Properly shielded 
interface cables with the shield connected to the chassis ground of the device must be used  
 

Evertz Microsystems Ltd This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: 
 
This device may cause harmful interference, and this device must 
accept any interference received, including interference that may 
cause undesired operation.  

 
Tested to comply 
with FCC 
Standards 

For Commercial Use 
 

 

EN60065 Safety  

 

EN504192 2005 
Waste electrical products should not 

be disposed of with household 
waste. Contact your Local Authority 

for recycling advice 

EN55103-1: 1996 Emission 
EN55103-2: 1996 Immunity 
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof, nor for the rights of third parties, which may be affected 
in any way by the use thereof.  Any representations in this document concerning performance of Evertz products are for informational use only and are not warranties of future performance, either 
expressed or implied. The only warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no warranty is granted nor liability assumed in relation to any 
errors or omissions unless specifically undertaken in the Evertz sales contract or order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated 
into subsequent editions.  If you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make changes in equipment design 
or specifications. 
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1. MVP™ QUICK START GUIDE 

This section describes how to quickly start using a standard MVP™ system. Further details, specifications, 
and instructions on the MVP™ and Maestro™ are provided herein. 
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1.1. SIMPLE MVP™ CONNECTIVITY 

The previous block diagram shows a simple connection between video inputs to an OV module, and its 
PLINK output to a display processor (“PPV”) module, and eventually to a monitor/display. Inputs A through 
H for both input modules are provided via coax cable with BNC connectors directly to the rear plates. 
PLINK OUT BNCs from these input module rear plates are connected using (at minimum) Belden 1694A 
cable to the PLINK IN input BNCs of the PPV module.  
 
The output of the PPV can be a straight-through DVI cable connected directly to the display. The DVI 
output of the 3000MVP-PPV-9 output processor module is a DVI-I standard, providing one DVI output 
simultaneously with one RGBHV output signal (both carry the same video display content information and 
cannot be independently configured). 
 
PLINK 1 or 2 from the OV card can be used to connect to the display cards in the MVP system.  It is 
standard to use the first PLINK output of the input card to connect to the first display card in the system.  If 
there is a second display card in the system, then the second PLINK output from the OV card can be used 
to provide video via PLINK . 
 
Simple MVP systems that consist of two or fewer display modules, and fewer than 13 input modules with 
no PLINK packet router present are configured at the factory with an on-board server.  In these systems, 
the user is only required to open the Maestro GUI client and enter the IP address of the display card that is 
running said “on board” server.  This will provide them with complete control of the MVP system for the 
purpose of defining layouts.  For more complex MVP systems that do not meet the criteria mentioned 
above, the PC-based sever must be configured on a PC and launched before proceeding to the Maestro 
software for layout design.  More details are described later in this manual regarding the use of the system 
configuration tools and system manager. 
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2. MVP™ SYSTEM OVERVIEW 

2.1. MVP™ FRAME (3000FR) 

The MVP™ multi-image display processor is housed in a 6RU, rack-mountable frame (3000FR). Each 
frame can accommodate up to two (2) hot-swappable power supply units  (3000PS) and up to fifteen (15) 
single slot, hot-swappable I/O modules. Each module has a corresponding, passive rear plate, which is 

mounted via three (3) screws to the frame. It is important that all 
three screws are used to fasten the rear plates to ensure proper 
connectivity with the I/O modules. 
 
The MVP™ frame is also equipped with a frame controller unit 
used for facilitating network communications between the frame 
modules and the MVP Maestro™ configuration software. The 
frame controller module (3000FC) is located under the left power 
supply unit, when looking directly at the front of the 3000FR 
frame. The network receptacle (RJ-45) is accessed on the back of 
the frame (see #1 on diagram). 
 
Each of the two power supplies is equipped with a separate power 
line cord, and provides PSU status information via LEDs on the 
front panel. 
 
The rear side of the 3000FR frame is also equipped with the 
following connections: 

  
3. NTSC Genlock via BNC 
4. PAL Genlock via BNC 
5. GROC Connector 

 

2.2. MVP™ I/O MODULES 

The MVP™ system is built from a variety of input and output modules. All modules are hot-swappable and 
can reside in any one of the 15 slots of the 3000FR frame. Available I/O modules include: 
 
3000MVP-OV-N Octal NTSC/PAL input module 

 
3000MVP-OV-SNX Auto detect, octal SD and NTSC/PAL input module (with embedded audio 

support), with extended data service decoding capability 

 
3000MVP-OV-HSN Auto detect, octal, HD, SD and NTSC/PAL input module (with embedded 

audio support)  

 
3000MVP-GI-4 Quad graphics input module (up to UXGA) 

 

3 

4 

5 

2 
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3000MVP-GI-2 Dual graphics input module (up to UXGA). 

 
3000MVP-AI Analog and AES/EBU audio input module. 

 
3000MVP-PPV-9 Video output processor and display module provides a single DVI-I output to 

UXGA (1600x1200) resolution display. 

 
3000MVP-PPV-9+D Dual video output processor and display module provides two unique DVI 

outputs (and 1 duplicated RGBHV) to two separate SXGA+ (1400 x 1050) 
resolution displays. 

 
3000MVP-PPMV13 Identical to the PPMV display card with four additional PLINK inputs, 

providing a total of 13 PLINK inputs, supporting up to 104 videos 

 
3000MVP-PPMX16-4G High-resolution multi-output display processor module, provides up to four 

unique GLINK outputs via coax or fiber at UXGA resolution on all four 
outputs, with 16 PLINK inputs allowing up to 128 unique video windows in 
standard PLINK fan configurations. 

 
3000MVP-PPMX16-4H4G High-resolution multi-output display processor module, provides up to 4 

unique GLINK outputs via fiber and 4 HD-SDI outputs at up to WUXGA 
resolution on all 4 outputs. 16 PLINK inputs allowing up to 128 unique video 
windows in standard PLINK fan configurations. 

 

3000MVP-PPMX16-8G High-resolution multi-output display processor module, provides up to 8 
unique GLINK outputs via fiber at up to 1920x1080p resolution on all 8 
outputs. 16 PLINK inputs allowing up to 128 unique video windows in 
standard PLINK fan configurations. 

 

3000MVP-PPMX16-8GC High-resolution multi-output display processor module, provides up to 8 
unique GLINK outputs via coax at up to 1920x1080p resolution on all 8 
outputs. 16 PLINK inputs allowing up to 128 unique video windows in 
standard PLINK fan configurations. 

 

3000MVP-PPR-16x16 PLINK packet router providing a total of 16 PLINK inputs to 16 PLINK 
outputs. 

 

3000MVP-GLINK4 Quad GLINK input card. 

 

3000MVP-EO/OE-5  Electrical to optical and optical to electrical converter. 
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3000DCP Desktop control panel. 

Detailed module descriptions, module rear plate drawings, and specifications are provided in sections 3.3 
to 3.18. 
 
Due to constant research and development, specifications are subject to change without notice. For the 
latest specification information, please visit www.evertz.com or contact your Evertz representative. 
 

2.2.1. Display Card Resolution Support 
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3000MVP-PPV9 × × × × × ×  ×  ×   
3000MVP-PPV9+D × × × × ×   ×     
3000MVP-PPMV13 × × × × × ×*  × × ×* × × 
3000MVP-PPMV+G × × × × × ×*  × × ×* × × 
3000MVP-PPMX16-4G × × × × × × × ×  ×   
3000MVP-PPMX16-4H4G × × × × × × × × × × × × 
3000MVP-PPMX16-8G × × × × × × × ×  ×   
3000MVP-PPMX16-8GC × × × × × × × ×  ×   
* Note:  only two of 4 outputs active at this resolution 
 

2.2.2. Display Card Output Support 
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3000MVP-PPV9 1 1 0 0 0 
3000MVP-PPV9+D 0 2 0 0 0 
3000MVP-PPMV13 0 4 0 0 4 
3000MVP-PPMV+G 0 4 4 0 4 
3000MVP-PPMX16-4G 0 0 4 4 0 
3000MVP-PPMX16-4H4G 0 0 4 0 4 
3000MVP-PPMX16-8G 0 0 8 0 0 
3000MVP-PPMX16-8GC 0 0 0 8 0 

2.2.3. MVP Cabling Recommended Lengths 

• PLINK (coax) max length = 20 meters, 65 feet 
• 2430GDAC GLINK (coax) max length = 10 meters, 33 feet 
• 2430GDAC GLINK (fiber) multi-mode max length = 100 meters, 330 feet 
• 2430GDAC GLINK (fiber) single-mode max power budget = 16dBm 

(10Km of cable under ideal conditions) 
• HD-SDI input (coax) max length = 100m, 330 feet  
• SD-SDI input (coax) max length = 250m, 820 feet 

http://www.evertz.com/
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• DVI digital max length = 3 meters, 10 feet1 
• VGA analog max length = 5 meters, 15 feet1 

 
1. Please make note that limitations are based on ideal cabling conditions, as well as ideal receivers/displays. 
 

2.3. INSTALLING AND REMOVING THE MODULES 

2.3.1. Installing the Module Rear Plate  

In most cases, the MVP™ frame will already have the module and rear plate installed within the frame. 
However, when modules and rear plates need re-positioning, or when additional modules are purchased, 
proper module/rear plate installation is required. 
 
Each MVP™ module is shipped with a matching rear panel plate that houses the appropriate connectors 
for that module.   
 
To install the MVP™ Rear Plate: 
 
1. Locate the specific slot in the frame and remove any filler plates.  
 
2. Install the rear plate over the open slot by first fitting the plate then tightening the two lock-screws.  
 
3. Fasten the third screw in the middle of the rear plate.  
 
4. Tighten the screws after the main module is installed. 
 

 

CAUTION: If any of the screws for the rear plate are missing, please contact 
Evertz immediately for the specification and/or replacement. Using the 
incorrect screw can cause thread stripping. 

 

2.3.2. Opening and Closing the Front Panel 

In order to insert or remove modules you will have to open the front panel using the following procedure: 
 
1. Turn the two captive screws located on the front panel counter clockwise several turns until they 

release completely from the front extrusions.   
 

2. Carefully lower the front panel door so that the front edge of the door is lower than the rear of the door.   
 

2.3.3. Installing a Module 

1. Orient the module vertically such that the smaller white card ejector is on the bottom, while the larger 
white/beige card ejector is on the top.   
 

2. Align the card with the card guide corresponding to the slot number where you installed the rear panel 
plate.   
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3. Carefully slide the module into the frame and press it completely into the rear panel connectors.  
 

4. Use the upper card-ejector to latch the module into the slot.   
 

5. Make sure that the connectors are fully seated in the rear panel.   
 

6. When this is done, close the front panel and then tighten the screws that hold the rear panel in place. 
 

2.3.4. Removing a Module 

1. Press the card ejector down to release the module.   
 

2. Grasp the card using the upper card ejector and pull the module out from the frame.   
 

3. Carefully place the module in a safe place, free from static discharge. 
 

2.4. MOUNTING 

The MVP™ frame is equipped with rack mounting rails and fits into a standard 19” x 10.5” x 14.5” rack 
space (483 mm x 260 mm x 368 mm).  To securely fasten the frame to the equipment rack, make sure 
that all four mounting screws on each mounting rail are tightened securely. 
 
After the unit has been installed in a rack, all cards in the frame should be checked to ensure they 
are fully seated within the frame.  This is best accomplished by simply pushing (simultaneously, with 
moderate force) on each card’s top and bottom insertion/extraction levers.  See section 2.3.3 for further 
information.  This step should be repeated any time the frame is shipped, or relocated within a facility. 
 

2.5. COOLING 

The MVP™ frame is designed to ensure adequate cooling for up to 600 watts of processing power per 
frame.  Fans at the front and rear of each power supply module accomplish forced air-cooling.  Adjacent 
equipment may be mounted immediately to the top and bottom of the frame.  Additional module cooling is 
provided by interior cooling channels to ensure that even fully loaded frames mounted adjacent to each 
other will operate within the normal temperature range.   
 

 

CAUTION:  For proper cooling, the frame must contain either two 3000PS power 
supplies, or one 3000PS power supply and one 3000PS-FM power supply blank 
panel with cooling fan.  

 

2.5.1. Fan Exhaust 

The cooling fans for the power supplies, located at the front of the frame, draw air in the front and exhaust 
out the sides of the frame.  The cooling fans for the modules, located at the rear of the frame, draw air in 
the front and the exhaust out the rear of the frame.   
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CAUTION:  To ensure adequate cooling, care should be taken to ensure that the 
fan inlets and exhaust openings are free of obstructions. 

 

2.6. SERVICING INSTRUCTIONS 

 

CAUTION: These servicing instructions are for use by qualified service 
personnel only.  To reduce the risk of electric shock, do not perform any 
servicing instructions in this section of the manual unless you are qualified to do 
so.  

 

2.6.1. Changing the Fuses  

 

CAUTION: For continued protection against the risk of fire, replace only with the 
same type and rating of fuse.  
 
ATTENTION: Pour éviter les risques d’incendie, remplacer le fusible avec un 
fusible de même calibre. 

 
The fuse holder is located inside the power entry module. To change the fuses, disconnect the line cord 
from the power entry module and pull the fuse holder out from the power entry module using a small 
screwdriver. The fuse holder contains two fuses, one for the line and one for the neutral side of the mains 
connection. Pull out the blown fuse and place a fuse of the correct value in its place. 
 
For 100-120 VAC operation, use ceramic time delay 5 x 20 mm fuses rated for 250 Volts with a 10 amps 
current rating.  For 220-240 VAC operation use ceramic time delay 5 x 20 mm fuses rated for 250 Volts 
with a 6.3 amps current rating. 
 
For your convenience there are spare fuses located in the vinyl pouch in the front of this manual.  
Carefully reinsert the fuse holder into the power entry module. 
 

2.6.2. Replacing the Power Supply 

Each power supply is a complete assembly, and includes the power supply cooling fan and one frame-
cooling fan.  In the event that the power supply or one of the fans malfunction, you will need to replace the 
power supply assembly with a spare one while the failed assembly is being repaired. 
 

 

CAUTION:  Do not run the frame for extended periods of time with one of the 
power supplies removed.  Proper cooling of the frame requires both power 
supplies to be inserted into the frame, or one power supply and a 3000PS-FM 
power supply blank panel. 
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The 3000PS power supplies are hot swappable and can be easily replaced from the front without 
interrupting the signal integrity of the frame.  Each power supply is capable of supplying full power to the 
frame by itself, however we recommend running with both supplies powered for power redundancy.  On 
frames with only one power supply, a 3000PS-FM blank power supply module with cooling fan must be 
inserted into the second power supply space.  The 3000PS-FM contains a module-cooling fan and baffles 
to maintain proper airflow within the frame. 
 
The power supply is secured into the frame by two machine screws through the rear panel (as shown in 
Figure 2-1).  These screws must be removed before the power supply can be extracted from the front.   
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Install
screw
here

Install
screw
here

 THIS EQUIPMENT HAS MORE THAN ONE POWER 
SUPPLY CORD. TO REDUCE RISK OF ELECTRIC SHOCK 
GROUNDING OF THE CENTER PIN OF POWER SUPPLY 
CORD PLUGS MUST BE MAINTAINED. DISCONNECT 
BOTH POWER SUPPLY CORDS BEFORE SERVICING 

FUSE: 100-120V: T10AH250V 
220-240V: T6.3AH250V

 

Figure 2-1: Locating the Power Supply Mounting Screw 
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CAUTION:  To reduce the risk of electric shock, you must replace the mounting 
screw after replacing the power supply. 

 

2.7. POWER  

The power entry modules contain a standard IEC power inlet connector, two 5 x 20 mm fuse holders, and 
an EMI line filter.   
 

 

CAUTION:  The 3000FR is shipped with 10 Amp fuses rated for 100-120 VAC 
operation.  If you are operating the MVP System in a country with nominal 220-
240 VAC operation, replace the fuses with 6.3 Amp fuses rated for 220-240 VAC 
operation.  See section 2.6.1 for information on changing fuses. 

 

2.7.1. Connecting the Power  

 THIS EQUIPMENT HAS MORE THAN ONE POWER
SUPPLY CORD. TO REDUCE RISK OF ELECTRIC SHOCK
GROUNDING OF THE CENTER PIN OF POWER SUPPLY
CORD PLUGS MUST BE MAINTAINED. DISCONNECT
BOTH POWER SUPPLY CORDS BEFORE SERVICING

FUSE: 100-120V: T10AH250V
220-240V: T6.3AH250V

 

Figure 2-2: Connecting the Power to the 3000FR 
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The 3000FR frame comes standard with one auto-ranging power supply (3000PS) that automatically 
senses the input voltage over the range of 100 to 240 VAC.  An additional power supply can be ordered to 
provide fully redundant powering of the frame.  When only one power supply is fitted, the frame will be 
fitted with a 3000PS-FM fan module to ensure the thermal integrity of the frame cooling.  In a frame that 
contains a redundant power supply module, each power supply may be powered from a different AC 
mains source, allowing complete AC supply redundancy.   
 
Power should be applied by connecting a three-wire, grounding-type power supply cord to the power entry 
module on the rear panel of each power supply.   For use in North America, the power cord should be a 
minimum 18 AWG wire size; type SVT marked VW-1, maximum 2.5 m in length.  For use outside North 
America, use a power cord approved for the country of use with a minimum 1.00 mm2 wire size. 
 

 

CAUTION: To reduce the risk of electric shock, grounding of the ground pin of 
the main plug must be maintained. 

 

2.7.2. Turning the Power On and Off 

Each power supply is fitted with its own power switch.  When the switch is turned off, the remaining power 
supply will power the frame.  To completely remove power from the frame, both power supplies must be 
turned off. 
 

2.7.3. Power Supply Status Indicators 

 

Figure 2-3: 3000PS Status Indicators 
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Each power supply has two status indicator LEDs.  The green PSU STATUS LED indicates the health of 
the local power supply.  The red FRAME STATUS LED indicates the health of the entire frame and is 
operated by the frame status buss of the frame.  The FRAME STATUS LED will be Off under normal 
conditions and On when there are Frame Status Fault conditions.  See section 2.8 for more information 
about the frame status buss fault conditions. 
 

 
On early versions of the 7700PS the FRAME STATUS LED is Green and will be On 
under normal conditions and Off when there are Frame Status Fault conditions.   

 
If one of the power supplies malfunctions, (power cord disconnected, power switch is off, fuse is blown, 
rear fan is stopped, etc,) then its PSU STATUS LED will go Off, and the red FRAME STATUS LED on 
both power supplies will turn On.  (If the power supplies are fitted with green FRAME STATUS LEDs they 
will turn Off)  The PSU STATUS LED on the power supply that is functioning will remain On.  If the frame 
is connected to VistaLINK® then the power supply fault will send a trap message from the frame. 
 

 

If there is a fuse failure, contact Evertz customer service regarding the power 
supply immediately.  The power supplies are short circuit protected and should 
not blow the fuse under a short circuit condition. 

 

2.8. FRAME STATUS FAULT CONDITIONS 

The Frame is fitted with a global Frame Status monitoring buss that is connected to each of the power 
supplies and to each of the modules.  When a fault condition occurs on one of the power supplies, or one 
of the modules, a Frame Status Fault condition is active on the frame status buss.  When this occurs the 
red FRAME STATUS LED on the power supply will come on and the relay on the Frame Status Tally 
terminal block will activate.  
 
Power supplies, will assert a frame status fault when their PSU STATUS LED is off.   
 
Each module has a large red LOCAL FAULT LED and a large green MODULE OK LED at the top of the 
card edge.  This green LED indicates good module health while the red LED indicates that there is a fault 
condition on the module.  Each module has its own criteria that determines when the red fault LED comes 
on. When the red LOCAL FAULT LED is On the module can also assert a fault condition on the Frame 
Status buss.  On each module there is a jumper that disables sending local card fault information to the 
Frame Status Buss.  For more information about fault conditions on individual modules, and for the 
location of the Frame Status Jumper on the module consult the individual chapter for the module.  For 
example, if a module requires video or audio for its functionality and the video or audio is not present, the 
red LOCAL FAULT LED on the module will be On and the fault will be reported on the frame status buss if 
the FRAME STATUS jumper on the module is set to the On position (default). 
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2.8.1. Frame Status Tally Terminal Block 

There is a green FRAME STATUS terminal block at the left rear of the frame that has a normally open and 
normally closed relay contact that can be used to indicate frame status fault conditions to external 
equipment.  There are 4 connections. 
 

Label Pin # Function 
G 1 Chassis Ground (connect to cable shield) 
R 2 Common (connect to Ground or your reference) 
O 3 Open with respect to common when Frame Status fault exists 
C 4 Closed with respect to common when Frame Status fault exists 

Table 2-1: Frame Status Tally Terminal Block Pin Assignments 

The relay contacts can sink up to 1A and operate up to 30 VDC. 
 

2.9. CARE AND HANDLING OF OPTICAL FIBER 

Some of the modules in the MVP™ system have fiber optic outputs.  The following safety information 
applies to the optical outputs of these modules. 
 

2.9.1. Safety 

The CLASS 1 LASER PRODUCT sign will appear as the following image: 
 

!
 

 
Background colour:  Yellow 
Triangular band:  Black 
Symbol:  Black 

 

2.9.2. Assembly 

Assembly or repair of the laser sub-module is done solely at the Evertz facility, and is performed only by 
qualified Evertz technical personnel. 
 

2.9.3. Labeling 

Certification and Identification labels are combined into one label. As there is not enough room on the 
product to place the label, it is reproduced here in the manual.  See Figure 2-4 below. 
 
Note: There is not a date of manufacture on this label as it can be traced by the bar code label placed on 

the printed circuit board of each Evertz plug-in module 
 

The Model number is one of: 3000MVP-PPMG, 3000MVP-PPMG13, 3000MVP-EO/OE-5 
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Figure 2-4: Reproduction of Laser Certification and Identification Label 

 

2.9.4. Handling and Connecting Fibers 

 

CAUTION: Never touch the end face of an optical fiber.  Always keep dust caps on 
optical fiber connectors when not connected and always remember to properly 
clean the optical end face of a connector before making a connection. 

 
Since the transmission characteristics of the fiber depend on the shape of the optical core, care must be 
taken to prevent fiber damage caused by heavy objects or abrupt fiber bending.  Evertz recommends that 
you maintain a minimum bending radius of 5 cm to avoid fiber-bending loss that will decrease the 
maximum attainable distance of the fiber cable.   
 
Dust particles on the ends of the optical fiber greatly increase the signal loss at interconnections, and large 
dust particles can even obscure light transmission altogether.  To minimize the effects of dust 
contamination at the interconnections, the fiber should be cleaned each time it is mated or unmated. When 
using interconnection housings to mate two optical fibers, it is good practice to remove dust particles from 
the housing assembly with a blast of dry air.  Alternatively, you can use the pre-moistened tissue that you 
should have received with the optical module.  Remove this tissue from its package and wipe the end of 
the fiber connector before mating it to the module.   
 
Whenever a fiber is unmated, it must be covered immediately.  Most fiber manufacturers provide a 
plastic boot that fits over the ferrule body for this purpose.  
 
Fiber interconnections must be made securely.  The Evertz fiber optical transmitters and receivers come 
with SC interconnection housings built into the module.  With this style of connector, the fiber assembly 
and the housing assembly can only be connected in one way and with very good repeatability.  The rear 
fiber interconnect panel that is provided with each module can be ordered with optional SC/PC, ST/PC, or 
FC/PC connectors.  The customer is required to provide the optical fiber with the correct connectors to 
connect the modules together.  SC/PC, ST/PC, and FC/PC interconnection housing and connectors (as 
well as adapters) are industry standards with many available sources. 
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3. SPECIFICATIONS 

3.1. 3000FR FRAME SPECIFICATIONS 

3.1.1. Genlock 

Type: NTSC (SMPTE 170M) and PAL (ITU624-4), colour black 
Level: 1Vp-p 
Connector: 2 BNC per IEC 61169-8 Annex A (1 each – NTSC and PAL) 
 

3.1.2. Electrical  

AC Mains Input: Auto ranging, 100  240 VAC, 50/60 Hz 
Maximum Operating Current:   9.5 A (@ 115 VAC nominal), 4.0 A (@ 220 VAC nominal) 
Maximum Power Consumption: 850 W 
Maximum Module Load:  610 W (40 W per slot & 10 W for Frame Controller) 
Power Supply Configuration: 1 supply standard, optional redundant supply requires separate inlet 
Connector:  IEC 60320 - 1 per power supply 
Fuses:  5 x 20 mm. ceramic – 2 per power supply 

For 115 VAC operation: 10 amp, 250 Volt time delay 
For 230 VAC operation: 6.3 amp, 250 Volt time delay 

 
Status Indicators (each power supply): 
 PSU status LED 
 Local Error/Failure LED 
Tally Output Connector: 4 pin terminal, relay N/O, N/C for status/fault alarm, 1A, 30 VDC max. 
Temperature: 0-40 deg. C. (optimal performance) 
 0-50 deg. C. (operating) 
 

3.1.3. Compliance 

Safety:  CSA Listed to CSA C22.2 No. 60065-03, UL 60065-03 
IEC 60065-(2001-12) 7th Edition 

  Complies with CE Low voltage Directive 93/68/EEC 
EMC:  Complies with FCC part 15, class A 
  Complies with EU EMC directive 89/336/EEC 
 

3.1.4. Physical 

Height:  10.5” (266 mm) 
Width:  19” (483 mm) 
Depth:  14.5” (368 mm) 
Module Capacity:  15 single slot 300 series modules 
Weight:  Approx. 17.4 lbs. (7.9 Kg) with 2 power supplies, no slots occupied 
  Approx. 32 lbs. (14.5 Kg) with 2 power supplies all slots occupied 
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3.2. 3000FC FRAME CONTROLLER MODULE 

The 3000FC Frame Controller module provides a single point of access to communicate with the 
3000MVP series of cards. The 3000FC provides a 10Base-T/100Base-TX Ethernet port and handles all 
communications between the frame and the Maestro software, and serves as a gateway to individual 
cards in the frame.  The 3000FC also provides an RS-232 serial port at the card edge to set up the 
network addresses.  
 
The 3000FC is housed in a narrow slot underneath the left side power supply in the 3000FR Frame. 
 

3.2.1. Specifications 

3.2.1.1. Ethernet 

Network Type: Fast Ethernet 100 Base-TX IEEE 802.3u standard for 100 Mbps baseband 
CSMA/CD local area network  

 Ethernet 10 Base-T IEEE 802.3 standard for 10 Mbps baseband CSMA/CD local 
area network  

Connector:  RJ-45 (on rear panel of 3000FR Frame) 
 

3.2.1.2. Serial Communications 

Standard: RS-232  
Connector:  9-Pin Female D connector on upgrade breakout cable (provided with 3000FR) 
Baud Rate: 57600 
Format: 8 bits, no parity, 2 stop bits, no flow control 
 

3.2.1.3. Electrical 

Voltage: + 12VDC 
Power: 7 Watts 
EMI/RFI: Complies with FCC Part 15 
 Class A and EU EMC directive 



  
MVP User's Guide 

 

SPECIFICATIONS Revision 2.8.7 Page 3-3 

3.3. 3000/3001MVP-OV-N 

This broadcast video input module is equipped with eight BNC video inputs, 
labeled A-H. Each input can support composite analog (NTSC/PAL). There are 
two additional BNC outputs labeled PLINK OUT that are used, along with a coax 
cable, to connect this video input module to the output processor display 
modules. 
 

3.3.1. Specifications 

3.3.1.1. Video 

Input Standards: NTSC (SMPTE 170M) and PAL (ITU-R BT.1700) 
Number of Inputs: 8 
Connector: BNC per IEC 61169-8 Annex A 
Input Impedance: 75 Ohms 
Signal Level (Analog): 1V nominal 
DC Offset (Analog): 0V +/- 1V 
Return Loss (Analog): >40Db up to 5MHz 
Output: PLINK (x2) – Evertz Proprietary 
 

3.3.1.2. Electrical 

Voltage: +12V DC 
Power: 40, all eight inputs 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC  
  Directive 
 

3.3.1.3. Physical 

Number of Slots: 1 
 

3.3.2. Ordering Information 

3000MVP-OV-N: 8 input Composite analog video input module 
 
Ordering Options: None 
 
Accessories: None 
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3.4. 3000/3001MVP-OV-SNX 

This broadcast video input module is equipped with eight BNC video inputs, labeled 
A-H. Each input can auto-detect whether the input is SD-SDI or composite analog 
(NTSC/PAL). There are two additional BNC outputs labeled PLINK OUT that are 
used, along with a coax cable, to connect this video input module to the output 
processor display modules.  The “SNX” was introduced to provide extended data 
services decode support, such as WST subtitle decode, WSS, Video Index decode, 
and thumbnailing.   
 

3.4.1. Specifications 

3.4.1.1. Video 

Input Standards: Auto-detecting 
 SMPTE 259M-C, 525 or 625 lines component 
 NTSC (SMPTE 170M) and PAL (ITU-R BT.1700) 
Number of Inputs: 8 
Connector: BNC per IEC 61169-8 Annex A 
Input Impedance: 75 Ohms 
Equalization (Digital): Automatic to >225m @ 270 Mb/s with Belden 8281 

(equiv.) 
Return Loss (SD-SDI): > 15dB up to 270MHz 
Jitter: <0.2 UI 
Embedded Audio: SMPTE 272M-A 
Signal Level (Analog): 1V nominal 
DC Offset (Analog): 0V +/- 1V 
Return Loss (Analog): >40Db up to 5MHz 
Output: PLINK (x2) – Evertz Proprietary 

3.4.1.2. Electrical 

Voltage: +12V DC 
Power: 43W, all eight inputs 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC Directive 

3.4.1.3. Physical 

Number of slots: 1 
 

3.4.2. Ordering Information 

3000MVP-OV-SNX 8 input auto sensing SD/Composite analog video input 
module 

 
Ordering Options: None 
 
Accessories: None 
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3.5. 3000MVP-OV-HSN 

This broadcast video input module is equipped with eight (8) BNC video inputs, 
labeled A-H. Each input can auto-detect whether the input is HD-SDI, SD-SDI or 
composite analog (NTSC/PAL). In addition, there are two (2) additional BNC outputs 
labeled “PLINK OUT” which are used, along with a coax cable, to connect this video 
input module to the output processor display modules. 
 

3.5.1. Specifications 

3.5.1.1. Video 

Standards: Auto-detecting 
 SMPTE 292M (1080i/60, 1080i/59.94, 1080i/50, 

720p/60, 720p/59.94, 480p/60, 480p/59.94, 
1080p/24sF, 1080p/23.98sF) 

 SMPTE 259M-C, 525 or 625 lines component 
 NTSC (SMPTE 170M) and PAL (ITU-R BT.1700) 
Number of Inputs: 8 
Connector: BNC per IEC 61169-8 Annex A 
Input Impedance: 75 Ohms 
Equalization (SD-SDI): Automatic to >225m @ 270 Mb/s with Belden 8281 

(equiv.) 
Equalization (HD-SDI): Automatic to 100m @ 1.5Gb/s with Belden 1694  

(equiv.) 
Return Loss (Digital): > 15dB up to 1.5 Gb/s 
Jitter: <0.2 UI 
Embedded Audio: SMPTE 272M-A (SD), SMPTE 299M (HD) 
Signal Level (Analog): 1V nominal 
DC Offset (Analog): 0V +/- 1V 
Return Loss (Analog): >40dB up to 5MHz 
Output: PLINK (x2) – Evertz Proprietary 
 

3.5.1.2. Electrical 

Voltage: +12V DC 
Power: 45W, all eight inputs 
EMI/RFI: Complies FCC Part 15, Class A, EU EMC Directive 
 

3.5.1.3. Physical 

Number of slots: 1 
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3.5.2. Ordering Information 

3000MVP-OV-HSN 8 input auto sensing HD/SD/Composite analog video input module 
 
Ordering Options: None 
Accessories: None 
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Figure 3-1: 3000MVP-OV-HSN and 3000MVP-GI Card LED Assignment 
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3.6. 3000MVP-OV-3G & 3001MVP-OV-HS 

These broadcast video input modules are equipped with eight (8) BNC video inputs, 
labeled A-H. Each input can auto-detect whether the input is 3Gbps (3000MVP-OV-
3G only), HD-SDI or SD-SDI. In addition, there are two (2) additional BNC outputs 
labeled “PLINK OUT” which are used, along with a coax cable, to connect this video 
input module to the output processor display modules. 

3.6.1. Specifications 

Please note: * denotes 3000MVP-OV-3G version only. 

3.6.1.1. Video 

Standards: Auto-detecting 
  SMPTE 424M (1080p/59.94, 1080p/50) 
 SMPTE 292M (1080i/60,1080i/59.94, 1080i/50, 

720p/60, 720p/59.94, 480p/60, 480p/59.94, 
1080p/24sF, 1080p/23.98sF) 

 SMPTE 259M-C, 525 or 625 lines component 
Number of Inputs: 8 
Connector: BNC per IEC 61169-8 Annex A 
Input Impedance: 75 Ohms 
Equalization (SD-SDI): Automatic to >225m @ 270 Mb/s with Belden 8281 

(equiv.) 
Equalization (HD-SDI): Automatic to 100m @ 1.5Gb/s with Belden 1694A 

(equiv.) 
* Equalization (3Gbps):  * Automatic to 50m @ 3Gb/s with Belden 1694A (equiv.) 
Return Loss (Digital): > 15dB up to 1.5 Gb/s 
Jitter: <0.2 UI 
Embedded Audio: SMPTE 272M-A (SD), SMPTE 299M (HD) 
Output: PLINK (x2) – Evertz Proprietary 
 

3.6.1.2. Electrical 

Voltage: +12V DC 
Power: 50W, all eight inputs 
EMI/RFI: Complies FCC Part 15, Class A, EU EMC Directive 
 

3.6.1.3. Physical 

Number of slots: 1 
 

3.6.2. Ordering Information 

3000MVP-OV-3G 8 input auto sensing 3G/HD/SD video input module 
3000MVP-OV-HS 8 input auto sensing HD/SD video input module 
Ordering Options: None 
Accessories: None 
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3.7. 3000MVP-GI-2, 3001MVP-GI-2-ED AND 3000MVP-GI-4, 3001MVP-GI-4-ED 
 
These computer video (progressive RGBHV or DVI) input modules are equipped 
with either two (2) or four (4) inputs, respectively. The 3000MVP-GI-2/3001MVP-GI-
2-ED can accept up to two computer inputs from VGA (640 x 480) to UXGA (1600 x 
1200) resolution. Similarly the 3000MVP-GI-4/3001MVP-GI-4-ED module can accept 
up to 4 computer inputs.  There are also two (2) additional BNC outputs labeled 
“PLINK OUT” which are used, along with a coax cable, to connect this input module 
to the output processor display module. 
 
Each model is shipped with DVI to VGA adaptors. Additional adaptors can be 
ordered from Evertz- see the ordering information in section 3.7.2. 

 
 
 
 
 

3.7.1. Specifications 

3.7.1.1. Graphics Inputs 

Standards: Auto-detecting,  
VESA (DVI-I, for DVI and RGBHV inputs) 

Number of Inputs: 2 on 3000MVP-GI-2, 3001MVP-GI-2-ED 
 4 on 3000MVP-GI-4, 3001MVP-GI-4-ED 
Connector: DVI-I 
Input Resolution: 640 x 480  to 1600 x 1200 – See table 
Signal Level: 1V nominal 

Computer Input Resolutions Supported 
 

640x480/60  640x480/72   640x480/75 
640x480/85  800x600/60  800x600/72 
800x600/75  800x600/85  1024x768/60 
1024x768/70  1024x768/75  1024x768/85 
1280x1024/60  1280x1024/75  1600x1200/60 
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3.7.1.2. Outputs 

Standard: PLINK  – Evertz Proprietary 
Number of Outputs: 2 
Connector: BNC per IEC 61169-8 Annex A 
 

3.7.1.3. Electrical 

Voltage: +12V DC 
Power: 40 to 45 W 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC Directive 
 

3.7.1.4. Physical 

Number of slots: 1 

3.7.2. Ordering Information 

3000/3001MVP-GI-2 Dual computer video auto sensing input module 
3000/3001MVP-GI-4 Quad computer video auto sensing input module 
 
Ordering Options: None 
  
Accessories: JDVIVGAMF DVI to VGA Adapter (One included for 

each graphics input) 
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3.8.  3000MVP-AI AND 3000MVP-AI-AESU 

The 3000MVP-AI handles up to 64 channels of analog audio (or up to 2 groups of analog 
audio per video input) and 32 AES inputs. The 3000MVP-AI-AES supports 32 unbalanced 
AES inputs only. Audio is applied to the MVP via dual SCSI connectors on the rear plate 
with optional BNC and terminal block connectors via breakout panels. Balanced and 
unbalanced audio inputs are supported via these breakout panels as depicted below.  
 

3.8.1. Specifications 

3.8.1.1. Audio Inputs 

Standards: SMPTE 276M, single ended AES (unbalanced) 
 Balanced analog audio 
Number of Inputs: 64 channel Analog Audio 
 32 channel AES/EBU 
Connector: Dual 68-pin SCSI (x3 sets) – balanced or unbalanced 

breakout panels available 
Resolution (Digital): 24-bit 
Impedance (Digital): 75 Ohm unbalanced 
Impedance (Analog): 20 kOhms minimum (differential) 
Sampling Frequency: 48 kHz (both Digital and Analog inputs) 
Peak Signal & Common Mode: 30 dBu (Analog) 
 

3.8.1.2. Electrical: 

Voltage: +12V DC 
Power: 35W 
EMI/RFI: Complies FCC Part 15, Class A, EU EMC Directive 
 

3.8.1.3. Physical 

Number of slots: 1 
 

3.8.2. Ordering Information 

3000MVP-AI Discrete input audio module 
 
3000MVP-AI+BHPBAL Discrete input audio module with balanced break out 

panel (Analog audio and/or balanced AES/EBU inputs) 
 
3000MVP-AI+BHPU Discrete audio input module with BNC break out panel 

(unbalanced AES/EBU inputs) 
 
3000MVP-AI+BHPU+BHPBAL Audio module with both BHP breakout panels  
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Ordering Options: None 
 
Accessories: BHP and SCSI cable as per table below 
 

3.8.2.1. 3000MVP-AI BHP Combinations and Ordering Information: 

 Audio Input Type BHP Type Ordering  Information 
Single ended (75 ohm) 
AES/EBU audio 3000BHP-U 3000MVP-AI+BHPU 

Balanced (110 ohm) 
AES/EBU audio 3000BHP-BAL 3000MVP-AI+BHPBAL 

Balanced analog stereo pair 3000BHP-BAL 3000MVP-AI+BHPBAL 

 

3.8.2.2. 3000MVP-AI SCSI Pin-out Detail (AES or Analog Audio) 

SCSI 
Pin # 

Balanced 
AES Input 

Unbalanced 
AES Input 

Analog Audio 
Input (SCSI 
1/SCSI 2) 

 SCSI 
Pin # 

Balanced 
AES Input 

Unbalanced 
AES Input 

Analog Audio 
Input (SCSI 
1/SCSI 2) 

1 AES 16+ AES 16 16+ / 48+  35 AES 16- GND 16- / 48- 
2 AES 8- GND 8- / 40-  36 AES 8+ AES 8 8+ / 40+ 
3 AES 15+ AES 15 15+ / 47+  37 AES 15- GND 15- / 47- 
4 AES 7- GND 7- / 39-  38 AES 7+ AES 7 7+ / 39+ 
5 AES 14+ AES 14 14+ / 46+  39 AES 14- GND 14- / 46- 
6 AES 6- GND 6- / 38-  40 AES 6+ AES 6 6+ / 38+ 
7 AES 13+ AES 13 13+ / 45+  41 AES 13- GND 13- / 45- 
8 AES 5- GND 5- / 37-  42 AES 5+ AES 5 5+ / 37+ 
9 AES 12+ AES 12 12+ / 44+  43 AES 12- GND 12- / 44- 

10 AES 4- GND 4- / 36-  44 AES 4+ AES 4 4+ / 36+ 
11 AES 11+ AES 11 11+ / 43+  45 AES 11- GND 11- / 43- 
12 AES 3- GND 3- / 35-  46 AES 3+ AES 3 3+ / 35+ 
13 AES 10+ AES 10 10+ / 42+  47 AES 10- GND 10- / 42- 
14 AES 2- GND 2- / 34-  48 AES 2+ AES 2 2+ / 34+ 
15 AES 9+ AES 9 9+ / 41+  49 AES 9- GND 9- / 41- 
16 AES 1- GND 1- / 33-  50 AES 1+ AES 1 1+ / 33+ 
17 N/C N/C N/C  51 N/C N/C N/C 
18 N/C N/C N/C  52 N/C N/C N/C 
19 AES 32- GND 32- / 64-  53 AES 32+ AES 32 32+ / 64+ 
20 AES 24+ AES 24 24+ / 56+  54 AES 24- GND 24- / 56- 
21 AES 31- GND 31- / 63-  55 AES 31+ AES 31 31+ / 63+ 
22 AES 23+ AES 23 23+ / 55+  56 AES 23- GND 23- / 55- 
23 AES 30- GND 30- / 62-  57 AES 30+ AES 30 30+/ 62+ 
24 AES 22+ AES 22 22+ / 54+  58 AES 22- GND 22- / 54- 
25 AES 29- GND 29- / 61-  59 AES 29+ AES 29 29+ / 61+ 
26 AES 21+ AES 21 21+ / 53+  60 AES 21- GND 21- / 53- 
27 AES 28- GND 28- / 60-  61 AES 28+ AES 28 28+ / 60+ 
28 AES 20+ AES 20 20+ / 52+  62 AES 20- GND 20- / 52- 
29 AES 27- GND 27- / 59-  63 AES 27+ AES 27 27+ / 59+ 
30 AES 19+ AES 19 19+ / 51+  64 AES 19- GND 19- / 51- 
31 AES 26- GND 26- / 58-  65 AES 26+ AES 26 26+ / 58+ 
32 AES 18+ AES 18 18+ / 50+  66 AES 18- GND 18- / 50- 
33 AES 25- GND 25- / 57-  67 AES 25+ AES 25 25+ / 57+ 
34 AES 17+ AES 17 17+ / 49+  68 AES 17- GND 17- / 49- 

 
Note: Two mounting pins connected to ground (GND). 
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3.9. 3000MVP-PPV-9 AND 3000MVP-PPV-9+D 

The “PPV” module processes the input signals from each of the 
input modules and provides an output display based on the user’s 
configuration via MVP Maestro GUI software.  Connections between 
the input modules and the output process/display module are made 
using a single coax cable with standard BNC connectors on both 
ends, connecting one “PLINK OUT” on the input module with one 
“PLINK IN” on the output processor module.  The “PPV-9” is 
equipped with nine (9) “PLINK IN” input BNC connectors. The 
module is equipped with a DVI-I output, providing both DVI and 
RGBHV outputs with the same display content. Furthermore, dual 
SCSI connectors provide auxiliary I/O connections such as 
GPI/GPO, audio monitoring outputs, serial ports (232/422) and LTC 
inputs. 
 
The dual output “+D” is a factory-set option and provides two 
independent DVI outputs from the same module. Outputs are 
provided on the same DVI connector and are broken out using the 
WP3000BHPDVIO cable. If you are not sure whether your unit is a 
PPV or a PPV+D, the card edge LED display will provide specific 
information. 
 

3.9.1. Specifications 

3.9.1.1. Video Inputs 

Input Standard: PLINK (Evertz Proprietary) 
Number of Inputs:  
3000MVP-PPV-9/-9+D: 9x PLINK (supports up to 9 video 

input modules) 
Input Connector: BNC per IEC 61169-8 Annex A 
Termination: 75 Ohms 
Equalization: Automatic 20m Belden 1694 (equiv.) 
Return Loss: > 15dB 
 

3.9.1.2. Video Output 

Type: DVI-I (on PPVs); dual DVI (on 
PPV+D) 

Connector: DVI-I 
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3.9.1.3. Auxiliary Outputs 

Connector: 68-pin dual SCSI (to one or two 3000BHP-AUX) 
Audio Monitoring Outputs: 4 AES unbalanced 
General Purpose Inputs: 64 
General Purpose Outputs: 44 
LTC Input: Differential 0.5 to 2 V P-P 
Data I/O Serial Port: 1 serial port (RS232 or RS422) 
 

3.9.1.4. Electrical 

Voltage: +12V DC 
Power: 50-60W 
EMI/RFI: Complies w/ FCC Part 15, Class A, EU EMC Directive 
 

3.9.1.5. Physical 

Number of slots: 2 
 

3.9.2. Ordering Information 

3000MVP-PPV-9  Single output display processor module – 9 PLINK video inputs 
3000MVP-PPV-9+D  Dual output display processor module – 9 PLINK video inputs 
 
Ordering Options: 3000BHP-AUX (one included with every PPV module) 
 WP3000BHPDVIO (one included with every “+D” module) 
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Figure 3-2: 3000MVP-PPV-9 card LED assignment 
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3.10. 3000MVP-PPMV13 

The “PPMV” module processes the input signals of up to 13 input modules and drives four independent 
output displays based on the user’s configuration via MVP Maestro GUI software. The 3-slot modules fit 
into a 3000FR frame and the connection between an input module and the PPMV are made using a single 
coax cable with standard BNC connectors on both ends. The user is required to connect one “PLINK 
OUT” on the input module to one “PLINK IN” on the output processor module. There are thirteen (13) 
“PLINK IN” input BNC connectors on each module. 
 
The “PPMV” module comes with two dual DVI outputs to drive 4 SXGA displays or 2 UXGA or greater 
displays via DVI-D breakout or 4 HD-SDI serial outputs via BNC connectors. This module comes equipped 
with two dual DVI break out cables providing the user with four DVI extensions to the displays.  The PPMV 
also offers 4 HD-SDI outputs, which provide the same content as the DVI outputs best fit to a HD-SDI 
raster.  For example, if the DVI resolution is set to 1280x720p then the HD-SDI output will be 720p, 
however for all other DVI resolutions the HD-SDI output will be 1920x1080i.  The “PPMV+G” modules add 
an additional 4 fiber GLINK outputs. 
 
In the “PPMV” modules, dual SCSI connectors provide auxiliary I/O connections such as GPI/GPO, audio 
monitoring outputs, serial ports (232/422) and LTC inputs. 
 

3.10.1. Specifications 

3.10.1.1. Video Input 

Input Standard: PLINK (Evertz Proprietary) 
Number of Inputs: 13 (3000MVP-PPMV13) 
Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
Equalization: Automatic 20m Belden 1694 (equiv.) 
Return Loss: > 15dB 
 

3.10.1.2. HD SDI Outputs 

Type: HD-SDI 
Connector: BNC per IEC 61169-8 Annex A 
Number: 4  
 

3.10.1.3. DVI Outputs 

Type: dual DVI 
Connector: DVI-I 
Output Resolution: 640 x 480  to 1600 x 1200  
Signal Level: 1V nominal 
Number:  2 
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3.10.1.4. Optical Outputs 

Type: G-LINK Optical (Evertz Proprietary)  - on PPMV+G only 
Connector: Female SC/PC, ST/PC or FC/PC (SC/PC is standard) 
Number: 4  
Return Loss: > 14 dB 
Rise and Fall Time: 200 ps nominal 
Wide Band Jitter: < 0.20UI 
Fiber Size: 9 µm core / 125 µm overall 
Wavelength: 1310nm (nominal) 
Output Power: -7dBm ± 1dBm 
 

3.10.1.5. Auxiliary Outputs 

Connector: 68-pin dual SCSI – to 3000BHP-AUX breakout panel 
Audio Monitoring Outputs: 4 AES unbalanced 

Connector:  BNC per IEC 61169-8 Annex A on breakout panel 
General Purpose Inputs: 64 
General Purpose Outputs: 44 
LTC Input: Differential 0.5 to 2 V P-P 
Data I/O Serial Port: 1 serial port (RS232 or RS422) 
 

3.10.1.6. Electrical Specification 

Voltage: +12V DC 
Power: 75W to 105W 
EMI/RFI: Complies w/ FCC Part 15, Class A, EU  
 EMC Directive 
 

3.10.1.7. Physical 

Number of slots: 3 
 

3.10.2. Ordering Information 

3000MVP-PPMV13  Multi output display processor module – 13 PLINK inputs, HDSDI and DVI out 
 
Ordering Options: 3000BHP-AUX (one included with every module)  
 
 WP3000BHPDVIO (one included with every PPMG module and two with every 

PPMV module) 
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3.11. 3000MVP-PPMX16-4G, 3000MVP-PPMX16-4H4G & 3000MVP-PPMX16-4H4V 

The “PPMX” modules process the input signals from up 16 input modules and drive four independent 
output displays based on the user’s configuration via the MVP Maestro GUI software. The 3-slot modules 
fit into a 3000FR frame and the connection between an input module and the PPMX are made using a 
single coax cable with standard BNC connectors on both ends. The user is required to connect one 
“PLINK OUT” on the input module to one “PLINK IN” on the output processor module. On each PPMX16 
module there are sixteen (16) “PLINK IN” input BNC connectors. 
 
The “PPMX16-4G” is equipped with 4 G-Link outputs (Evertz proprietary serial connection) to drive 
resolution up to WUXGA (1920x1200) including HDTV (1920x1080) and UXGA on all 4 outputs.  The G-
Link output provides a 10m cable length over coax and also provides a built-in extension over fiber (75m 
via multi-mode fiber and up to 10km – subject to sufficient loss budget - using single mode fiber).  A 
2430GDAC is required to convert the G-Link signal back to VGA or DVI at the display end of the link. 
 
The “PPMX16-4H4G” is equipped with 4 fiber G-Link outputs (Evertz proprietary serial connection) to drive 
resolution up to WUXGA (1920x1200) including HDTV (1920x1080) and UXGA on all 4 outputs.  The G-
Link provides a built-in DVI extension over fiber (75m via multi-mode fiber and up to 10km – subject to 
sufficient loss budget - using single mode fiber).  A 2430GDAC is required to convert the G-Link signal 
back to VGA or DVI at the display end of the link.  The “4H4G” also offers 4 HD-SDI outputs, which 
provide the same content as the DVI outputs best fit to a HD-SDI raster.  For example, if the DVI 
resolution is set to 1280x720p then the HD-SDI output will be 720p, however for all other DVI resolutions 
the HD-SDI output will be 1920x1080i.  The best fit resolutions for using the HD-SDI output which is 
parallel to the GLINK output is either 1280x720 = 720p over HD-SDI, or 1920x1080p = 1920x1080i over 
HD-SDI. 
 
The “PPMX16-4H4V” is equipped with 4 DVI outputs which can be driven up to WUXGA (1920x1200). The 
“4H4V” also offers 4 HD-SDI outputs which provide the same content as the DVI outputs best fit to a HD-
SDI raster.  For example, if the DVI resolution is set to 1280x720p then the HD-SDI output will be 720p, 
however, for all other DVI resolutions the HD-SDI output will be 1920x1080i.  The best fit resolutions for 
using the HD-SDI output which is parallel to the GLINK output is either 1280x720 = 720p over HD-SDI, or 
1920x1080p = 1920x1080i over HD-SDI. 
 
Dual SCSI connectors on the back plate provide auxiliary I/O connections such as GPI/GPO, audio 
monitoring outputs, serial ports (232/422) and LTC inputs. 
 

3.11.1. Specifications 

3.11.1.1. Video Input 

Input Standard: PLINK (Evertz Proprietary) 
Number of Inputs: 16 
Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
Equalization: Automatic 20m Belden 1694 (equiv.) 
Return Loss: > 15dB  
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3.11.1.2. GLINK Outputs 

Type: G-LINK (Evertz Proprietary) 
Connector: BNC per IEC 61169-8 Annex A 
Number: 4 (3000MVP-PPMX16-4G only) 
 

3.11.1.3. Optical Outputs 

Type: G-LINK Optical (Evertz Proprietary) 
Connector: Female SC/PC, ST/PC or FC/PC (SC/PC is standard) 
Number: 4  
Return Loss: > 14 dB 
Rise and Fall Time: 200 ps nominal 
Wide Band Jitter: < 0.20UI 
Fiber Size: 9 µm core / 125 µm overall 
Wavelength: 1310nm (nominal) 
Output Power: -7dBm ± 1dBm 
 

3.11.1.4. HD SDI Outputs 

Type: HD-SDI 
Connector: BNC per IEC 61169-8 Annex A 
Number: 4 (3000MVP-PPMX16-4H4G) 
 

3.11.1.5. Auxiliary Outputs 

Connector: 68-pin dual SCSI – to 3000BHP-AUX breakout panel 
Audio Monitoring Outputs: 4 AES unbalanced 
Connector:  BNC per IEC 61169-8 Annex A on breakout panel 
General Purpose Inputs: 64 
General Purpose Outputs: 32 
LTC Input: Differential 0.5 to 2 V P-P 
Data I/O Serial Port: 1 serial port (RS232 or RS422) 
 

3.11.1.6. DVI Outputs 

Type: DVI 
Connector: DVI-I 
Output Resolution: 640 x 480 to 1920 x 1200  
Signal Level: 1V nominal 
Number: 4 
 
 



  
MVP User's Guide 

 

SPECIFICATIONS Revision 2.8.7 Page 3-21 

3.11.1.7. Electrical Specification 

Voltage: +12V DC 
Power: 105 to 110 W 
EMI/RFI: Complies w/ FCC Part 15, Class A, EU  
 EMC Directive 
 

3.11.1.8. Physical 

Number of Slots: 3 
 

3.11.2. Ordering Information 

3000MVP-PPMX16-4G  Multi output display processor module – 16 PLINK inputs, GLINK outputs 
3000MVP-PPMX16-4H4G  Multi output display processor module – 16 PLINK inputs, 4 HD-SDI 

outputs and 4 GLINK outputs 
3000MVP-PPMX16-4H4V Multi output display processor module – 16 PLINK inputs, 4 HD-SDI 

outputs and 4 DVI-I outputs 
 
Ordering Options: 3000BHP-AUX (one included with every module) 
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3.12. 3000MVP-PPMX16-8G AND 3000MVP-PPMX16-8GC 

The “PPMX” modules process the input signals from up 16 input modules and drive eight independent 
output displays based on the user’s configuration via the MVP Maestro GUI software. The 3-slot modules 
fit into a 3000FR frame and the connection between an input module and the PPMX are made using a 
single coax cable with standard BNC connectors on both ends. The user is required to connect one 
“PLINK OUT” on the input module to one “PLINK IN” on the output processor module. On each PPMX16  
module there are sixteen (16) “PLINK IN” input BNC connectors. 
 
The “PPMX16-8G” is equipped with 8 G-Link outputs (Evertz proprietary serial connection) to drive 
resolution up to HDTV (1920x1080) and UXGA on all 8 outputs.  The G-Link output provides a built-in DVI 
extension over fiber (75m via multi-mode fiber and up to 10km – subject to sufficient loss budget - using 
single mode fiber).  A 2430GDAC is required to convert the G-Link signal back to VGA or DVI at the 
display end of the link. 
 
The “PPMX16-8GC” is equipped with 8 coax G-Link outputs (Evertz proprietary serial connection) to drive 
resolution up to HDTV (1920x1080) and UXGA on all 8 outputs.  The G-Link provides a built-in DVI 
extension over coax (10m via Belden 1694A).  A 2430GDAC is required to convert the G-Link signal back 
to VGA or DVI at the display end of the link. 
 
Dual SCSI connectors on the back plate provide auxiliary I/O connections such as GPI/GPO, audio 
monitoring outputs, serial ports (232/422) and LTC inputs. 
 

3.12.1. Specifications 

3.12.1.1. Video Input 

Input Standard: PLINK (Evertz Proprietary) 
Number of Inputs: 16 
Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
Equalization: Automatic 20m Belden 1694 (equiv.) 
Return Loss: > 15dB  
 

3.12.1.2. GLINK Outputs 

Type: G-LINK (Evertz Proprietary) 
Connector: BNC per IEC 61169-8 Annex A 
Number: 8 (3000MVP-PPMX16-8GC only) 
 

3.12.1.3. Optical Outputs 

Type: G-LINK Optical (Evertz Proprietary) 
Connector: Female SC/PC, ST/PC or FC/PC (SC/PC is standard) 
Number: 8 (3000MVP-PPMX16-8G only) 
Return Loss: > 14 dB 
Rise and Fall Time: 200 ps nominal 
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Wide Band Jitter: < 0.20UI 
Fiber Size: 9 µm core / 125 µm overall 
Wavelength: 1310nm (nominal) 
Output Power: -7dBm ± 1dBm 
 

3.12.1.4. Auxiliary Outputs 

Connector: 68-pin dual SCSI – to 3000BHP-AUX breakout panel 
Audio Monitoring Outputs: 4 AES unbalanced 
  
Connector:  BNC per IEC 61169-8 Annex A on breakout panel 
General Purpose Inputs: 64 
General Purpose Outputs: 32 
LTC Input: Differential 0.5 to 2 V P-P 
Data I/O Serial Port: 1 serial port (RS232 or RS422) 
 

3.12.1.5. Electrical Specification 

Voltage: +12V DC 
Power: 105 to 110 W 
EMI/RFI: Complies w/ FCC Part 15, Class A, EU  
 EMC Directive 
 

3.12.1.6. Physical 

Number of slots: 3 
 
Ordering Information: 
3000MVP-PPMX16-8G  Multi output display processor module – 16 PLINK inputs, 8 fiber GLINK 

outputs 
3000MVP-PPMX16-8GC Multi output display processor module – 16 PLINK inputs, 8 coax GLINK 

outputs 
 
Ordering Options:  3000BHP-AUX (one included with every module)  
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3.13. 3000MVP-PPR-16X16 

The 3000MVP-PPR-16x16 module is a PLINK packet router. Using PLINK 
(patent-pending technology) the router allows up to 16 input cards to be 
connected to up to 16 displays, and provide any input to any output. 
 
Due to its ability to place any input on any output display, using the PPR router 
can virtually eliminate the need for an upstream router feeding the MVP. 
 
Interconnect from the input cards to the PPR or the PPR to the display cards is 
achieved using Belden 1694A coax cable over lengths up to 10 m (30 feet). 
 

3.13.1. Specifications 

3.13.1.1. Video Input 

Standard: PLINK (Evertz Proprietary) 
Number of Inputs: 16 (3000MVP-PPR-16x16) 
Input Connector: BNC per IEC 61169-8 Annex A 
Termination: 75 Ohms 
Equalization: Automatic 10m Belden 1694 (equiv.) 
Return Loss: > 15dB 
 

3.13.1.2. Video Output 

Standard:   PLINK (Evertz Proprietary) 
Number of Outputs: 16 (3000MVP-PPR-16x16) 
 

3.13.1.3. Electrical 

Voltage: +12V DC 
Power: 80W 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC 

Directive 
 

3.13.1.4. Physical 

Number of slots: 3 
 

3.13.2. Ordering Information 

3000MVP-PPR-16x16: 16 Input x 16 output PLINK Packet Router module 
 
Ordering Options:  None 
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3.14. 3000MVP-GLINK4 

These GLINK input modules accept GLINK sources directly from GLINK enabled display 
devices, such as the 3000MVP-PPMG and the 7707RGT-GC.  The device is capable of 
supporting any of the output video standards supported by the above mentioned devices. 
 

3.14.1. Specifications 

3.14.1.1. Video Inputs 

Type: GLINK (Evertz proprietary) 
Number of Inputs: 4 
Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
 

3.14.1.2. Video Outputs 

Type: PLINK – Evertz Proprietary 
Number of Outputs: 2 
Connector: BNC per IEC 61169-8 Annex A 
 

3.14.1.3. Electrical 

Voltage: +12V DC 
Power: 45 W 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC Directive 
 

3.14.1.4. Physical 

Number of slots: 1 
 

3.14.2. Ordering Information 

3000MVP-GLINK4 Quad GLINK input card 
 
Ordering Options: None 
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3.15. 3000MVP-OE-5 AND 3000MVP-EO-5 

The 3000MVP-OE-5 and EO-5 are optical to electrical and electrical to optical 
conversion modules.  The primary function of this module is to extend the PLINK 
interconnect of the MVP between input and output modules.  Using the EO-5 paired 
with the OE-5, up to 5 PLINK interconnects can be transported over fiber up to 10Km 
with single mode fiber.  The module is also used to convert optical GLINK signals from 
devices such as the 3000MVP-PPMG and the 7707RGBT-GF. 
 

3.15.1. 3000MVP-EO-5 I/O Specifications 

3.15.1.1. Video Input 

Type: Electrical PLINK/GLINK (Evertz Proprietary) 
Number of Inputs: 5  
Input Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
Equalization (PLINK): Automatic 10m Belden 1694 (equiv.) 
Return Loss (PLINK): > 15dB 
 

3.15.1.2. Video Output 

Type:  Optical PLINK/GLINK (Evertz Proprietary) 
Connector: Female SC/PC, ST/PC or FC/PC (SC/PC is standard) 
Number: 5  
Return Loss: > 14 dB 
Rise and Fall Time: 200 ps nominal 
Fiber Size: 9 µm core / 125 µm overall 
Wavelength: 1310nm (nominal) 
Output Power: -7dBm ± 1dBm 
 
 

3.15.2. 3000MVP-OE-5 I/O Specifications 

3.15.2.1. Video Input 

Type: Optical PLINK/GLINK (Evertz Proprietary) 
Number of Inputs: 5  
Connector: Female SC/PC, ST/PC or FC/PC (SC/PC is standard) 
Receive Sensitivity: -24dBm 
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3.15.2.2. Video Output 

Type: Electrical PLINK/GLINK (Evertz Proprietary) 
Number of Outputs: 5 
Connector: BNC per IEC 61169-8 Annex A 
Impedance: 75 Ohms 
 

3.15.3. Electrical 

Voltage: +12V DC 
Power: 10 W 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC Directive 
 

3.15.4. Ordering Information 

3000MVP-EO-5 5 input PLINK/GLINK electrical to optical converter 
3000MVP-OE-5 5 input PLINK/GLINK optical to electrical converter 
 
Ordering Option: None 
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3.16. 3000DCP 

The 3000DCP desktop control panel, provides an easy to 
use interface to the MVP for recalling presets and 
performing on display window selection.  The 3000DCP 
allows for the simple recall of up to 20 presets per display to 
a total of 20 displays.  Multi-purpose buttons allow the user 
to program specific functions into the DCP.  Functions such 
as salvo recalls of the entire walls or “emergency” display 
fail over conditions. The shaft encoder and direction buttons 
allow for on screen selection.  Remote connection of the 
DCP is provided via Ethernet, the panel can be placed 
anywhere in the facility provided it is on the same Ethernet 
network as the MVP.  Interactive dot matrix display allows 
for simple feedback from the DCP when performing 
operations. 
 

3.16.1. Specifications: 

3.16.1.1. Physical 

Dimensions: 10.2” w x 6.5” h x 2.6” t  
Weight: 2lbs (902g) 
 

3.16.1.2. Operational 

Display buttons:   10 (+10 with shift) 
Preset buttons:   10 (+10 with shift) 
Multi-purpose buttons: 7 
 

3.16.1.3. Communications 

Ethernet Interface: RJ-45 connector 
 

3.16.1.4. Electrical 

Voltage: 12 VDC Nominal 
 Auto-ranging 100 to 240 VAC 50/60 Hz power adapter included 
Power: 30 watts 
EMI/RFI: Complies with FCC Part 15, Class A, EU EMC Directive 
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3.17. GENERAL PURPOSE INPUTS AND OUTPUTS (VIA DISPLAY MODULES) 

GPI interfacing with the MVP is possible through general-purpose inputs and outputs available on each of 
the output display modules (on the dual SCSI connector). The display modules are shipped with 
3000BHP-AUX breakout panels that are connected using the SCSI cable provided. The GPIs are active 
low with internal pullup resistors (4.7k Ohms) to +5 V. To make an input active, lower the signal to near 
ground potential (i.e. connect to shell or chassis ground). This can be done with a switch, relay, TTL drive, 
GPO output, or using another similar method. Figure 3-3 shows the input circuit for the general-purpose 
inputs.  Figure 3-5 shows an example of how to interface the MVP GPI inputs to higher voltage systems. 
 

GND

To Internal
Circuit

4.7 kΩ

GPI

+ 5 Volts

 

Figure 3-3: GPI Input Circuitry 

 
The GPO’s are active low with internal pull up (10kΩ) resistors to +5V. When the output goes low it is able 
to sink up to 10mA.  When high, the signal will go high (+5V).  Do not draw more than 100µA from the 
output. Figure 3-4 shows the circuit for the general-purpose output. 
 

From Internal
Circuit

10k Ω

+ 5 Volts

GND

GPO
10 Ω

 

Figure 3-4: GPO Output Circuitry 
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1N4148
Diode

24V = working
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Example: Control Device

24VDC
 (working voltage)

GPO

MVP GND

MVP GND GPI of MVP

note:  the control device
and the MVP GNDs

must be tied together

  

Figure 3-5: Interfacing GPIs to a High Voltage GPI System 

 

3.18. SERIAL INTERFACE (VIA OUTPUT MODULES) 

External serial communication with the MVP is possible through built-in RS-232/RS-422 ports available on 
each of the output display modules (on the dual SCSI connector).  The display modules are shipped with 
3000BHP-AUX breakout panels that are connected using the SCSI cable provided. See section 3.22.4 for 
more information on using the 3000BHP-AUX breakout panels.  Typically, the user can drive 1000 ft on an 
RS-422 run. 
 
To configure and module for a particular serial protocol, see the table in section 3.19. 
 

3.18.1. RS-232 Mode  

• Point-to-point connection - one driver, one receiver 
• Two wires plus GND, max cable length 50 ft 

 
Set J34 and J33 (on the PPV module) to the 232 position. 
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Connect the serial port on the 3000BHP-AUX terminal block J3 as follows: 
 

RX --> data into MVP (RX) 
TX --> data out from MVP (TX) 
CTS --> not connected 
RTS --> not connected 

 

3.18.2. RS-422 Mode 

• Multi-point connection - supports one driver and 10 receivers 
• Must be terminated with 100 ohm resistor at one end 
• Four wires plus shield, max cable length 3600 ft 

 
Set J34 and J33 (on the PPV module) to 422 position. 
 
Connect the serial port on the 3000BHP-AUX terminal block J3 as follows: 
 

RX --> data into MVP (RX-) 
CTS --> data into MVP (RX+) 
TX --> data out from MVP (TX-) 
RTS --> data out from MVP (TX+) 
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3.19. 3000MVP-PPV-X SCSI A AND SCSI B PIN ASSIGNMENT TABLE 

SCSI 
Pin # Signal SCSI 

Pin # Signal  SCSI 
Pin # Signal SCSI 

Pin # Signal 

A1 GND A35 GPO 1  B1 GND B35 GPO 23 
A2 GND A36 GPO 2  B2 GND B36 GPO 24 
A3 GPI 1 A37 GPO 3  B3 GPI 33 B37 GPO 25 
A4 GPI 2 A38 GPO 4  B4 GPI 34 B38 GPO 26 
A5 GPI 3 A39 GPO 5  B5 GPI 35 B39 GPO 27 
A6 GPI 4 A40 GPO 6  B6 GPI 36 B40 GPO 28 
A7 GPI 5 A41 GPO 7  B7 GPI 37 B41 GPO 29 
A8 GPI 6 A42 GPO 8  B8 GPI 38 B42 GPO 30 
A9 GPI 7 A43 GPO 9  B9 GPI 39 B43 GPO 31 
A10 GPI 8 A44 GPO 10  B10 GPI 40 B44 GPO 32 
A11 GPI 9 A45 GPO 11  B11 GPI 41 B45 GPO 33 
A12 GPI 10 A46 GPO 12  B12 GPI 42 B46 GPO 34 
A13 GPI 11 A47 GPO 13  B13 GPI 43 B47 GPO 35 
A14 GPI 12 A48 GPO 14  B14 GPI 44 B48 GPO 36 
A15 GPI 13 A49 GPO 15  B15 GPI 45 B49 GPO 37 
A16 GPI 14 A50 GPO 16  B16 GPI 46 B50 GPO 38 
A17 GPI 15 A51 GPO 17  B17 GPI 47 B51 GPO 39 
A18 GPI 16 A52 GPO 18  B18 GPI 48 B52 GPO 40 
A19 GPI 17 A53 GPO 19  B19 GPI 49 B53 GPO 41 
A20 GPI 18 A54 GPO 20  B20 GPI 50 B54 GPO 42 
A21 GPI 19 A55 GPO 21  B21 GPI 51 B55 GPO 43 
A22 GPI 20 A56 GPO 22  B22 GPI 52 B56 GPO 44 
A23 GPI 21 A57 AES OUT 1  B23 GPI 53 B57 GPO 45 
A24 GPI 22 A58 AES OUT 2  B24 GPI 54 B58 GPO 46 
A25 GPI 23 A59 AES OUT 3  B25 GPI 55 B59 GPO 47 
A26 GPI 24 A60 AES OUT 4  B26 GPI 56 B60 GPO 48 
A27 GPI 25 A61 RX1  B27 GPI 57 B61 RX2 
A28 GPI 26 A62 TX1  B28 GPI 58 B62 TX2 
A29 GPI 27 A63 CTS1  B29 GPI 59 B63 CTS2 
A30 GPI 28 A64 RTS1  B30 GPI 60 B64 RTS2 
A31 GPI 29 A65 LTC 1 IN +  B31 GPI 61 B65 LTC 2 IN + 
A32 GPI 30 A66 LTC 1 IN -  B32 GPI 62 B66 LTC 2 IN - 
A33 GPI 31 A67 GND  B33 GPI 63 B67 GND  
A34 GPI 32 A68 GND  B34 GPI 64 B68 GND 

 

3.20. MVP™ BREAK-OUT I/O PANELS 

Audio Breakout Panels: 3000BHP-U 
  3000BHP-BAL  

Dual Video Breakout Cable: WP3000BHPDVIO  
Auxiliary Breakout Panel: 3000BHP-AUX 
BHP Mounting Kit: 3000MKT-BHP 
 

B A 

1 

1 
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3.20.1. 3000BHP-U  
(Option Included with AI modules - Identified as 3000MVP-AI+BHPU) 

The 3000BHP-U Bulkhead Breakout Panel is a 1RU panel equipped with 32 BNC inputs to accommodate 
up to 32 AES/EBU audio sources. Each panel ships with a single SCSI cable that is used to link it to the 
rear plate of either of the 3000MVP-AI modules. 
 

 
 

3.20.2. 3000BHP-BAL  
(Option Included with AI Modules - Identified as 3000MVP-AI+BHPBAL) 

The 3000BHP-BAL Bulkhead Breakout Panel is a 2RU panel equipped with 34 terminal block (1x6) 
connectors to accommodate up to 64 balanced analog audio inputs. Each panel ships with a two SCSI 
cables that are used to link it to the rear plate of either of the 3000MVP-AI modules. 
 

 
 
An audio connection diagram is provided in a subsequent section of this manual for balanced analog 
audio and AES/EBU inputs as well as unbalanced AES/EBU. 
 

3.20.3. WP3000BHPDVIO CABLE (PPV9+D, PPMV) 

 

Figure 3-6: WP3000BHPDVIO Breakout Cable 

 
The WP3000BHPDVIO break out cable replaces the 3000BHP-DVIO breakout module. This cable 
provides the user with a break-out solution to display 2 separate monitors via DVI from a dual DVI source 
output of the PPV+D or PPMV/G module. 
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3.20.4. 3000BHP-AUX (Included with all PPV and PPMV Display Card Modules) 

The 3000BHP-AUX provides the user with a breakout solution for auxiliary inputs and outputs including 
GPI/GPO, monitoring audio outputs, LTC inputs and serial communication lines. The interconnection 
between the BHP and the rear plate are SCSI connectors, with the input to BHP shown in the “Bottom 
View” picture below. One 3000BHP-AUX is used per SCSI cable.  The functions of the pins for J1 and J2 
change depending on whether the 3000BHP-AUX is connected to SCSI connector A or B.  Connector J3 
is only connected on the panel connected to SCSI connector A.  There is a place on the 3000BHP-AUX 
silkscreen for you to identify which SCSI connector the panel is connected to.  
 
The GPI inputs require a contact closure to active them.  The GPI outputs (GPO) are open collectors and 
sink current when active. There is a GPO bias voltage available on the Vext pin.   
 

 
The Vext pin is to be used as a pull-up bias for the general-purpose outputs only.  
The Vext pin cannot supply enough current to power any external devices. 

 

 

Figure 3-7: Top View 

 

Figure 3-8: Bottom View (to PPV-x Module via SCSI Cable, Factory-Provided) 

 



  
MVP User's Guide 

 

SPECIFICATIONS Revision 2.8.7 Page 3-37 

The various GPI/GPO connections are displayed below for configuration with a single 3000BHP-AUX 
(Connector A) and with two 3000BHP-AUX breakouts (Connector A and Connector B). 
 

 

Figure 3-9: AES, LTC and Serial Data Ports (Connected to PPV-x Module SCSI A) 

 
 
 

 

Figure 3-10: GPIO Connections when Connected to PPV-x Module SCSI A 
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Figure 3-11: GPIO Connections when Connected to PPV-x Module SCSI B 

3.20.5. 3000MKT-AUX Breakout Panel Mounting Kit 

For mounting convenience, a breakout panel mounting kit is available with mounting hardware. It is shown 
in the picture below with two BHPs.  This ships standard with all MVP display cards. 
 
 

 

Figure 3-12: Mounting Breakout Panels Using the 3000MKT-AUX Breakout Panel Mounting Kit 
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4. MVP™ NETWORK CONFIGURATION 

4.1.1. Part 1: Making the Network Connections 

The MVP™ requires only a single network connection via good quality, straight-thru Ethernet cable, 
terminated at both ends with RJ-45 male connectors, as shown in Figure 4-1. 
 

Ethernet
 

Figure 4-1: Making the Ethernet Connection 

 
The MVP™ is designed to be used with either 10Base-T (10 Mbps) or 100Base-TX (100 Mbps) also 
known as Fast Ethernet, twisted pair Ethernet cabling systems.  When connecting for 10Base-T systems, 
category 3, 4, or 5 UTP cable as well as EIA/TIA – 568 100Ω STP cable may be used.  When connecting 
for 100Base-TX systems, category 5 UTP cable is required.  The cable must be straight-through, with an 
RJ-45 connector at each end.  Make the network connection by plugging one end of the cable into the RJ-
45 receptacle of the MVP Frame and the other end into a port of the supporting switch. If only connecting 
a single PC to one MVP frame, a single crossover or straight-through network connection will work. If 
more network elements exist, an external network switch will be required. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pinout information in 
Table 4-1.  A colour-code wiring table is provided in Table 4-1 for the current RJ 45 standards (AT&T 258A 
or EIA/TIA 258B colour coding included). Also refer to the notes following the table for additional wiring 
guide information.  
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Pin 
1 

 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required) 
5 N/A White/Blue White/Blue Not used (required) 
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required) 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required) 

Table 4-1: Standard RJ45 Wiring Colour Codes 

 
Note the following cabling information for this wiring guide: 
 

• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins; a crossover cable made for one will also work with the 

other. 
• Pairs may be solid colours instead of striped. 
• Category 5 cables must use Category 5-rated connectors. 

 
The maximum cable run between the MVP™ and the supporting hub is 300 ft (90 m).  The maximum 
combined cable run between any two end points (i.e. MVP™ and PC/laptop via network hub) is 675 feet 
(205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity. The MVP network connection port is fitted with two LEDs to 
monitor the Ethernet connection.  
 
10/100: This LED is ON when a 100Base-TX link is last detected.  The LED is OFF when a 

10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is 
OFF as the last detected rate is unknown and therefore defaults to the 10Base-T 
state until rate detection is complete.  

 
LN/ACT: This dual purpose, green LED indicates that the MVP module has established a 

valid link to its hub, and whether the MVP module is sending or receiving data.  This 
LED will be ON when the MVP module has established a good link to its supporting 
hub.  This indicates that the segment is wired correctly. The LED will BLINK when 
the MVP module is sending or receiving data. The LED will be OFF if there isn’t a 
valid connection. 
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4.1.2. Part 2: Connecting Serial Communications to the MVP Modules 

MVPs are shipped with an Evertz standard “PB Upgrade” cable (part number WA-S76). Connect the 
computer to the card edge serial port by placing the 7700PB serial upgrade cable to the 2x3 header of a 
module. On video input modules (OV-x and GI-x), the header is located next to the front card-edge 
between the LEDs and the toggle switch (for example, J4 on the OV and GI modules – see Figure 1 of this 
section).  On PPV-x modules, J13 is located near the front card-edge (Figure 2 of this section - black). On 
older video output modules, header J13 is located toward the lower middle portion of the main board 
(Figure 2 of this section - grey). 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note that pins 1 and 5 on the header should be removed, and pins 1 and 5 on the cable connector should 
also be plugged. If the cable is not keyed, make sure that you install it so that the cable is away from the 
front of the frame when the module is installed (i.e. so that it passes over the full length of the card). Pin 1 
of the ribbon cable is brown and will be facing the edge of the module with the card ejector when the cable 
is installed correctly. 
 

7700FC End  PC End 
2 row X 

3 pin Berg Pin 6 Conductor 
Ribbon Cable 

9 pin D 
Female Pin 

Key 1 Brown  1 
Rx 2 Red Tx 2 
Tx 3 Orange Rx 3 

Tx Gnd 4 Yellow Gnd 5 
Key 5 Green   
--- 6 Blue   

Table 4-2: 7700PB Upgrade Cable (WA-S76) 

 

4.1.3. Part 3: Terminal Program Setup 

1. Start the terminal program and configure the port settings of the terminal program for the OV, GI and 
PPV modules as follows: 

 
Baud 115200 
Data bits 8 
Parity None 
Stop bits 2 
Flow Control None 

Figure 1 Figure 2 

OV and GI 
Modules 

 

Front of Frame Front of Frame 

PPV Module 
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2. The port settings of the terminal program for the AI and FC modules are as follows: 
 

Baud 57600 
Data bits 8 
Parity None 
Stop bits 2 
Flow Control None 

 
3. Install the cable onto the jumper of the module, and then slide the module into the frame.   
 

4.1.4. Part 4: Setting IP Addresses on MVP Modules 

Every MVP input (OV and GI) module and output (PPV) module is shipped with a factory assigned IP 
address. These IP addresses are listed on a table and included with every frame (paper copy, usually 
attached to the frame lid). If a particular card is not included in this frame, it is removed from the table. 
Alternatively, if a new card is added to this frame, its type and IP address is also added to this table. The 
generic IP address sheet per frame appears as follows: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The IP addresses of each module have been pre-assigned to the values listed for testing purposes.  You 
may leave them as they are or change them to better reflect your exact network topology. If you want to 
change the IP address, please follow the steps listed below. 

 

Module Pre-assigned IP address Slot # 
3000FC 192 168 9 1  
3000MVP-PPV 192 168 9 2  
3000MVP-OV 192 168 9 3  
3000MVP-OV 192 168 9 4  
3000MVP-OV 192 168 9 5  
3000MVP-OV 192 168 9 6  
3000MVP-OV 192 168 9 7  
3000MVP-OV 192 168 9 8  
3000MVP-OV 192 168 9 9  
3000MVP-OV 192 168 9 10  
3000MVP-OV 192 168 9 11  
3000AI 192 168 9 12  
3000AI 192 168 9 13  
3000AI 192 168 9 14  
3000AI 192 168 9 15  
3000AI 192 168 9 16  
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4.1.4.1. Set the IP Address and Configure the “PPV” or “PPMx” Module 

As described in Step 2 above, the upgrade cable is connected to jumper J13 and the PPV-x module and is 
re-seated into the frame. Once the frame is powered-up, the HyperTerminal connection displays boot-up 
status information and, once completed, ends with the Main Menu selection as shown below: 

 
 -------------------------------------------------------- 
|                        Main Menu                   | 
|                     (3000PPV 2.8.2)                    | 
 --------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Display Wall Test 
(7) Hardware Test Menu 
(8) Engineering/Debug 
 
(X) Exit 

 
 

To open a menu item, type the corresponding number from the list, and then press <ENTER>. Remember 
to SAVE when a change has been made before exiting the menu. 
 
Menu item (1) is the Network Configuration, in which you set the IP address properties for this output 
module. 
 

 -------------------------------------------------------- 
|                  Network Configuration                 | 
|                     (3000PPV 2.8.2)                    | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
ENET: 0  MAC: 00:02:c5:fe:b1:25 
 
ip address:        192.168.0.14 
netmask address:   255.255.255.0 
gateway:           0.0.0.0 
broadcast address: 192.168.0.255 
DHCP enabled: False 
 ------------------------------------------------ 
(1) Set IP Address 
(2) Set Netmask 
(3) Set Gateway 
(4) Set Broadcast Address 
(5) Use DHCP 
 
(S) Save and Exit 
(X) Exit 

 
In this menu, selecting options (1) through (4) allows the user to set the networking parameters of the PPV 
module. DHCP is not recommended, as control of the MVP requires static IP addresses. Once you have 
configured the IP, save and exit this menu by selecting “S”. All modules ship with DHCP disabled (or 
DHCP enabled set to “FALSE”). If you are not sure whether you should use this option, contact your 
networking/IT administrator.  



 
MVP User's Guide 
 

Page 4-6 Revision 2.8.7 NETWORK CONFIGURATIONS 

Once you have returned to the Main Menu, select option (2) Onboard Server Configuration, and then 
select (1) Display Connection Status to see what input and output modules are configured and 
connected. Configuration is not possible in this menu option; it is simply a connection status summary. 
 

 
Note:  This option is only applicable for non PC-based MVP systems. 

 
--------------------------------------------------------- 
|               Onboard Server Configuration            | 
|                     (3000PPV 2.8.2)                   | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Enabled 
Onboard VGPId: Disabled 
Onboard DCPd: Enabled 
Onboard SymphD: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
(6) Enable symphd 
 
(S) Save and Exit 
(X) Exit 
 

Name    IP              Status 
--------------------------------- 
DC1     192.168.0.19    CONNECTED 
DC2     192.168.0.22    CONNECTED 
IC1     192.168.0.42    CONNECTED 
IC2     192.168.0.43    CONNECTED 
IC3     192.168.0.44    CONNECTED 
IC4     192.168.0.45    CONNECTED 
IC5     192.168.0.46    CONNECTED 
IC6     192.168.0.47    CONNECTED 
IC7     192.168.0.49    CONNECTED 
IC8     192.168.0.50    CONNECTED 
IC9     192.168.0.52    CONNECTED 
IC10    192.168.0.53    CONNECTED 
IC11    192.168.0.136   CONNECTED 

 
Select option (3) Utilities if you wish to clear the system settings on this display module. 

 
--------------------------------------------------------- 
|                        Utilities                      | 
|                     (3000PPV 2.8.2)                   | 
 -------------------------------------------------------- 
(1) Clear NV High Level (no system settings) 
(2) Clear NV Low Level (clear entire flash) 
 
(X) Exit 
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Select option (4) Under Monitor Display Setup if you want to configure the dynamic UMD interface to 
this output module. The source of information and type of protocol along with interconnect information is 
entered through this menu. 

 
 -------------------------------------------------------- 
|               Under Monitor Display Setup              | 
|                     (3000PPV 2.8.2)                    | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
 Protocol:     Image Video 
 Input Type:   network 
 TCP Port:     9800 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 

 
Choosing (1) Set Protocol provides a list of protocols (as below) for you to select. Typing the 
corresponding number sets the protocol.  Please refer to section 9 of this manual for further information on 
setting protocols. 

 
Select UMD protocol: 
1. Image Video 
2. Philips ASCII 
3. XY Integrator 
4. TSL 
5. Echo 
(1-5) > 

 
 

(5) Auxiliary Serial Port Setup – This menu option sets the output module’s serial port attributes. These 
attributes must agree with those being presented from the interfacing box. 

 
 ------------------------------------------------------- 
|               Auxiliary Serial Port Setup             | 
|                     (3000PPV 2.8.2)                   | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Baud Rate:      115200 
Data Bits:           8 
Parity:           None 
Stop Bits:           2 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 

 
(6) Display Wall Test, (7) Hardware Test Menu, and (8) Engineering/Debug menu items are used by 
Evertz Service personnel only. 
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4.1.4.2. Set the IP Address and Configure the “OV” and/or “GI” Module 

As described in Step 2 above, the upgrade cable is connected to jumper J4 and the module is re-seated 
into the frame. Once the frame is powered-up, the HyperTerminal connection displays boot code and, 
once completed, ends with the Main Menu selection. 

 
 ---------------------------------------------- 
|                   Main Menu                  | 
|              (3000OV 2.6.1 b6498)            | 
 ---------------------------------------------- 
(1) Network Configuration 
(2) SNMP Configuration 
(3) Audio Configuration 
(4) Video Utilities 
(5) Global Card Utilities 
(6) Engineering Debug Utility 
 
(X) Exit 

 
Select (1) Network Configuration to set the IP address of the specific OV module. 
 

 ---------------------------------------------- 
|             Network Configuration            | 
|              (3000OV 2.6.1 b6498)            | 
 ---------------------------------------------- 
---------------------------------- 
MAC: 00:02:c5:fe:ba:81 
 
ip address:        192.168.0.42 
netmask address:   255.255.255.0 
gateway:           0.0.0.0 
broadcast address: 192.168.0.255 
DHCP enabled: False 
---------------------------------- 
(1) Set IP Address 
(2) Set Netmask 
(3) Set Gateway 
(4) Set Broadcast Address 
(5) Use DHCP 
 
(S) Save and Exit 
(X) Exit 

 
Selecting menu option (1) sets the IP address of the card. Options (2) – (4) set the remaining networking 
parameters for this input module, while option (5) allows the user to have the DHCP-supported server 
automatically set a non-conflicting IP address for this module (not recommended). Option “S” saves the 
configuration and exits this menu. 

 
Option (2) on the Main Menu sets the SNMP trap destination and for fault/TRAP monitoring from the OV 
modules. 
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 ---------------------------------------------- 
|               SNMP Configuration             | 
|              (3000OV 2.6.1 b6498)            | 
 ---------------------------------------------- 
---------------------------------- 
Trap Destination 1: 192.168.1.214 
---------------------------------- 
 
(1) Set Trap IP Address 
(2) Remove Trap IP Address 
 
(S) Save and Exit 
(X) Exit 

 
Options (3) Audio Configuration, and (4) Video Utilities are no longer used.  The parameters within are 
now configured using the System Configuration Tool.   
 

 
Please note that the Hide Softkey Code is not applicable in most applications. 

 
Option (5) Global Card Utilities is an engineering tool and should not be accessed during regular set-up 
or operation. 
 
Once changes are completed and the modules have saved (automatic upon exiting) new configurations, 
simply remove the serial connection and shutdown the HyperTerminal connection. The frame must then 
be power-cycled. 
 
Configuration of the GI modules is very similar to that detailed above, with some slight variations. 

 
 ----------------------------------------------- 
|                   Main Menu                  | 
|             (3000GI v2.6.0 b2209)            | 
 ----------------------------------------------- 
(1) Network Configuration 
(2) SNMP Configuration 
(3) Audio Configuration 
(4) Video Utilities 
(5) Global Card Utilities 
(6) Engineering Debug Utility 
 
(X) Exit 

 
 



 
MVP User's Guide 
 

Page 4-10 Revision 2.8.7 NETWORK CONFIGURATIONS 

Menu item (2) SNMP Configuration allows you to set or remove a Trap IP Address by selecting the 
corresponding number. 
 

 ----------------------------------------------- 
|               SNMP Configuration             | 
|             (3000GI v2.6.0 b2209)            | 
 ----------------------------------------------- 
---------------------------------- 
No Trap Destinations Assigned 
---------------------------------- 
 
(1) Set Trap IP Address 
(2) Remove Trap IP Address 
 
(S) Save and Exit 
(X) Exit 

 
Use (4) Video Utilities to set the size and position, as well as the gain and black level.   
 
Cropping is set using the Crop Setup window in the System Configuration Tool (Hardware Settings > 
Properties > Crop Setup).  To use this feature: 
 
1. Open the System Configuration Tool. 
 
2. Click on the Hardware Settings Tab. 
 
3. Highlight the appropriate Video Input. 
 
4. Click Properties. 
 
5. Click the Crop Setup tab. 
 
6. Input the required crop values into the text fields. 
 

 ------------------------------------------------ 
|                Video Utilities                | 
|             (3000GI v2.6.0 b2209)             | 
 ------------------------------------------------ 
(1) Crop 
(2) Size and Position 
(3) Gain and Black Level 
 
(S) Save and Exit 
(X) Exit 
> 

 
The (5) Global Card Utilities menu item is an engineering tool and should not be accessed during regular 
set-up or operation. 
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5. MAPPING DISCRETE AUDIO TO VIDEO INPUTS 

This MVP™ chapter covers: 
 

• Wiring discrete audio into a BHP 
• Configuring the following modules to handle discrete audio (analog or digital AES/EBU) via the 

3000MVP-AI (with associated BHP): 
o 3000MVP-OV-SN  
o 3000MVP-OV–HSN 
o 3000MVP-OV-SNX 
o 3000MVP-OV-N 

 
Audio (balanced or unbalanced AES/EBU and balanced analog) is provided via the AI module through 
BHP panels and is wired based on the following diagrams (rear plate connections are all through right-side 
female SCSIs only).  
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Discrete AI audio modules are positioned in the frame in the adjacent slot to an OV card. One AI module 
can support: 
 

• A single OV module, and provide up to two groups of AES/EBU audio, or four pairs of analog 
audio per video input  

• Two OV modules, and provide up to one group of AES/EBU audio, or two pairs of analog audio 
per video input  

 
Note: In this case, the AI module must be positioned between two OV modules. 

 
• Four OVs – a single AES (pair) of audio 

 
Associating discrete audio inputs with video signals (a.k.a. audio mapping) takes place in the adjacent OV 
cards. Audio is mapped using the System Configuration Tool by following the procedure below:  
 
1. Open the System Configuration Tool. 
 
2. Click on the Hardware Settings tab. 
 
3. Highlight the appropriate OV. 
 
4. Click the Properties button. 
 
5. Click the Audio Setup tab.  This opens the window in Figure 5-1 below: 
 
 

Figure 5-1: Audio Setup Window 
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6. Set the parameters described below as required for your particular application. 
 

5.1. AUDIO MENU ITEMS 

Audio Type: 
This menu option allows you to choose between the following audio types: Discrete Unbalanced AES, 
Discrete Balanced Analog, Embedded AES, or Discrete Balanced AES. 
 
Group 1: 
Selects which pairs of audio (e.g.: AES1/AES2) will be assigned to Group 1. 
 
Group 2: 
Selects which pairs of audio (e.g.: AES1/AES2) will be assigned to Group 2. This group can also be 
disabled. 
 
Level Bar Type: 
In this menu option, you can choose VU + PPM, or PPM level bar types.  The VU + PPM option displays 
both an average audio level indicated by a solid bar, and peak average audio indicated by a white marker. 
 
Phase Bar Type: 
This setting allows you to choose between Stereo and DIN. 
 
PPM Type: 
Offers different standards for audio level scales. 
 
Error Region: 
Set this parameter to determine what audio level will be considered an error. 
 
Warning Region: 
Set this parameter to determine what audio level will be considered a warning.  Please note that when 
using analog audio, the Warning Region is synonymous with the Reference, even though the field label 
does not change. 
 
AI Position: 
Use this parameter to set the AI module’s position in the frame (either left or right) relative to the OV 
module. 
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6. MODULE UPGRADES 

There are two primary upgrade processes available to the user: File Transfer Protocol (FTP) and Serial 
Upload. Both are described below for specific I/O modules. 
 

6.1. NETWORKING FUNDAMENTALS (FTP UPGRADE PROCESS) 

Before any FTP (file transfer protocol) upgrades can be initiated:  
 

• Modules must be pre-configured with IP addresses (see section 2.3 and 4). 
• The user must determine the IP address of the PC/laptop.  
• All nodes must be on the same subnet for the FTP upgrade to work properly.  

 
This process is used with “OV”, “GI” and “PPV” modules, but will not work with the 3000FC and 3000MVP-
AI modules. For the latter products, please refer to the product-specific section for upgrade details. 
 
To check if a proper network connection has been established: 

 
1. Connect the network cable from the PC/laptop to the MVP frame.  

 
2. Open a Command Prompt window (Start > Programs > Accessories > Command Prompt) on the 

PC/laptop.  
 

3. Ping the IP address of the module being upgraded. For example: 
 

C:\ ping 192.168.9.100 <Enter> 
 
If a proper network connection has been established, a “reply” is displayed on the DOS window.  
 
If the network connection is faulty, a “Destination Host Unreachable” message is provided. This means 
that either the IP addresses of the nodes should be verified or the network (Ethernet) cable is faulty. For 
more information, please see section 2.3 and 4 of this manual. 

 

6.2. UPGRADING THE APPLICATION CODE 

The following instructions outline the process required to upgrade the application code for the modules 
listed below: 

 
3000MVP-PPV-5/9+D   
3000MVP-PPV-5/9   
3000MVP-GI-2/4 
3000MVP-AI 
3000MVP-PPMV/G 
3000MVP-VGO 

3000MVP-GO 
3000MVP-OV-SN/HSN 
3000FC 
3000MVP-PPR-12x10 
3000MVP-PPR-16x16 
3000DCP 

 
 
For any modules not listed above, please contact your Evertz representative for further upgrade 
instructions. 
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Prior to initiating the upgrade process, confirm the version of code currently installed on the module by 
examining the card-edge LED. The version information is cycled regularly and frequently on this display. If 
necessary, press the push-button to start the display process.  
 
Also, prior to starting the upgrade: 
 

• Verify that there is new application code to upgrade by contacting your Evertz representative. 
 

 
Note: Be sure to ask for a list of new features provided in the upgrade. 

 
• Verify that you have the correct firmware for the right card (i.e.: that the firmware you are installing 

is meant to be used with this card). 
 

There are three upgrade processes available to the user for the list of modules below: File Transfer 
Protocol (FTP), Serial Upload, and the System Configuration GUI software. Both FTP and Serial Upgrade 
methods are described below for specified Video I/O modules. See the System Configuration tool section 
for instructions on using the GUI for upgrades.  Using the System Configuration tool is the recommended 
method. 

 
3000MVP-OV-SN 
3000MVP-OV-SNX 
3000MVP-OV-HSN 
3000MVP-GI-2 
3000MVP-GI-4 
3000MVP-PPV-5 
3000MVP-PPV-9 
3000MVP-PPV-5+D 
3000MVP-PPV-9+D 
3000MVP-PPMV/13 
3000MVP-PPMG/13 
3000MVP-PPMX13/16 

 

6.2.1. VIDEO I/O FTP Upgrade Method 

1. Identify and confirm the IP addresses of the module and PC/laptop, and ensure that they are on the 
same subnet. 

 
2. Power on the MVP system with the module installed in the MVP frame. 

 
3. Obtain the new application code from the FTP site and place it on the PC’s local drive. 

 
4. Open a DOS window by selecting Start > Run, and typing “cmd” in the window that appears, as 

shown in Figure 6-1. 
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Figure 6-1: Run Window 

 
5. In the DOS window type: ftp xxx.xxx.xxx.xxx (where the x’s represent the module’s IP address). 
 
6. Press <ENTER> when prompted for a “Username”, and again when prompted for a “Password”. 
 
7. At the “FTP>” prompt, type “quote site upgrade”. 
 
8. At the “FTP>” prompt, type “put x.bin”, where x represents the name of the application (.bin) file.  
 

 

Note: If the application file is not local to where you are performing the FTP, then 
include the path with the name: 

(e.g.: “put c:\mvp\ov\app\3000OV_180903.bin”) 

 
9. A message indicating the successful connection to the module is displayed. 
 
10. At this time, the card-edge will show a “% complete” value, indicating that the card is now uploading 

the new code. During this time it is mandatory that all power cycles of the module or frame be avoided. 
 
Upon completion, the input modules will enable a small red LED on the card-edge indicating that the 
transfer was successful, and that the module is waiting for a power cycle before the new code will take 
effect.  
 

 
Note:  The display card does not have this feature. 

 
After upgrading any PPV-x module, it is important to clear display memory before new code takes 
effect. This can be done as follows: 
 
1. On the PPV-x card edge, lift dip switches 2, 3, and 4 to the “up” position. 

 
2. Power cycle the PPV. 

 
3. Wait approximately 30 seconds after power cycling, then put dip switches 2, 3, and 4 back down to 

their default position. 
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4. Power cycle the card again. 
 

6.2.2. VIDEO I/O Serial Upload Method 

This method transfers the new application code via the upgrade serial port on the front edge of the 
module. 
 
1. Turn off the MVP frame containing the module that is to be upgraded. 
 
2. Connect the factory-supplied 7700PB serial upgrade cable to J4 on the front edge of the OV card, and 

connect the other end of this cable to a serial port on a PC with a serial terminal program. 
 

Note: Jumper J13 on PPV-x modules. 
 

3. Place a jumper across pins 2 and 3 on J12 (“Upgrade” mode). 
 

Note: Jumper J5 on PPV-x modules. 
 

4. Set up the serial communication properties for the COM port (see section 4.1.3 to obtain serial port 
settings for a specific module). 

  
5. Power on the MVP frame with the module installed. 
 

When the module boots-up, “PPCBOOT>” is displayed on the terminal screen. 
 

6. At the prompt type “upload”, then press <ENTER>.   
 

The following message will be displayed: 
 
  Upload product firmware now 
 

7. Upload the application code by using the send file function in the terminal software. When prompted, 
use the “Xmodem” protocol for data transfer. 

 
When the transfer is complete (which can take up to 30 minutes or more) the terminal will return to the 
PPCBOOT prompt.  You should: 
 
1. Turn off the MVP frame. 

 
2. Remove the module from the MVP frame and remove the upgrade serial cable. 

 
3. Place a jumper across pins 1 and 2 on J12 (“Run” mode). 

 
 Note: J5 on PPV-x modules 
 

4. Re-insert the module into the MVP frame. 
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6.2.3. Upgrading 3000FC Application Code 

The 3000FC is upgraded via the configuration serial port (J7) near the front edge of the card. 
 
1. Turn off the MVP frame with the FC card that is to be upgraded. 
 
2. Connect the 7700PB serial upgrade cable supplied with the MVP frame to the J7 on the front edge of 

the FC card and connect the other end of this cable to a serial port on a PC with a serial terminal 
program. 

 
3. Place a jumper across pins 1 and 2 on J7 (“Upgrade Mode”). 
 
4. Set up the serial communication properties for the COM port as follows: 
 

COM:   Select the COM port 
Bits per second:   57600 
Data bits:   8 
Parity:   None 
Stop bits:   2 
Flow control:  None 

 
5. Power on the MVP frame with the FC card installed. 
 
6. When the FC card boots up, the following information will be printed on the terminal screen: 
 

EVERTZ MCF5272 MONITOR 2.3 BUILD 3 (66 MHZ) 
COPYRIGHT 1997, 1998, 1999, 2000, 2001, 2002 EVERTZ MICROSYSTEMS LTD. 
28F160C3B FLASH DETECTED 
BRD=3000FC 
MODEL=BA3000FC 
PROD=3000FC 
FRAME=3000FR 
UPGRADE JUMPER INSTALLED 
 
UPLOAD FILE NOW, CONTROL-X TO CANCEL 

 
7. To upload the FC with the new application code, use the send file function in the terminal software. 
  

 
Note:  If prompted, use the “Xmodem” protocol for data transfer. 

 
The download can take up to 5 minutes to complete, a message will indicate that the upload is “OKAY”. 
Execute the following steps when the download is complete:  
 
1. Power down the MVP frame.  

 
2. Remove the FC card from the frame.  

 
3. Disconnect the upgrade serial cable, and place a jumper across pins 2 and 3 on J7. 
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4. Insert the FC card back into the MVP frame and power up the MVP frame. 
 

6.2.4. Upgrading 3000MVP-AI, 3000MVP-VGO, 3000MVP-GO, 3000MVP-PPR  
Application Code 

The 3000MVP-AI, VOG, GO, PPR are upgraded via the configuration serial port (J51) near the front edge 
of the card.  The 3000MVP-AI card is used as an example for the upgrade procedure. 
 
1. Turn off the MVP frame with the AI card that is to be upgraded. 
 
2. Connect the 7700 serial upgrade cable supplied with the MVP frame to J51 on the front edge of the AI 

card, and connect the other end of this cable to a serial port on a PC with a serial terminal program. 
 
3. Place a jumper across pins 2 and 3 on J49 (“Upgrade mode”). 
 
4. Set up the serial communication properties for the COM port as follows: 
 

COM:     Select the COM port that the serial cable is connected to.  
Bits per second:   57600 
Data bits:   8 
Parity:   None 
Stop bits:   2 
Flow control:  None 

 
5. Power up the MVP frame with the AI card installed. 
 
6. When the AI card boots up, the following information will be printed on the terminal screen: 
 

EVERTZ MCF5272 MONITOR 1.0 BUILD 22 (66 MHZ) 
COPYRIGHT 1997, 1998, 1999, 2000, 2001, 2002 EVERTZ MICROSYSTEMS LTD. 
28F160C3B FLASH DETECTED 
PROD=3000AI 
MCF5272 COLD BOOT> /     (type “CTRL-X”) 
MCF5272 COLD BOOT> upgrade   (type “upgrade”) 
ARE YOU SURE YOU WANT TO UPLOAD FLASH? [Y/N] Y 
 
UPLOAD FILE NOW, CONTROL-X TO CANCEL 
�����     (using the transfer/send file function, send the app.bin) 
UPLOAD OKAY 
BOOT> 

 
7. Type CTRL-X at the first prompt, as is depicted above. This will put the AI card in the upload flash 

mode.   
 

 
Note: If the cold-boot prompt times out, the AI card will have to be re-booted. 

 
8. Type “upgrade” at the prompt (see above for an example). 
 
9. When the confirmation message appears, asking if you wish to upload the flash, type “Y”. 
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10. To upload the AI with the new application code, use the send file function in the terminal software, if 

prompted use the Xmodem for transfer. 
 
The download can take up to 5 minutes to complete, a message will indicate that the upload is “OKAY”.  
 
When the download is complete:  
 
1. Power down the MVP frame.  

 
2. Remove the AI card from the frame. 

 
3. Disconnect the upgrade serial cable.  

 
4. Place a jumper across pins 1 and 2 on J49 (“Run mode”). 

 
5. Insert the AI card back into the MVP frame. 

 
6. Power up the MVP frame. 
 
The application code upgrade is now complete. 
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7. MVP™ SOFTWARE 

7.1. PC MINIMUM REQUIREMENTS 

• Windows 2000 PRO/Server/Windows XP PRO 
• P4 2.6GHz or higher 
• 512MB RAM 
• 80GB HDD 
• 10/100 Ethernet Nic 
• From XGA to UXGA screen resolution supported 
• Windows 2000 operating system 
• CD-ROM player 

 

7.2. INSTALLING SOFTWARE 

1. Contact Evertz service for an update on the latest software.  MVP software is only available through a 
private FTP site. 

 
2. After obtaining the latest software from Evertz, run the software installer by double-clicking on the 

setup .exe  
 

e.g.:  mvp-setup-2.5.2.exe 
 
3. Follow the installer’s instructions.  
 

 

Note: You must install the Maestro software and the System Manager. The System 
Configuration Tool is not required for the PC-based server install because this is built into the 
System Manager Utility. 

 
4.  After completing the install, you will have two icons on your desktop:  MVP Maestro and MVP System 

Manager (See Figure 7-1). 
 
 

 

Figure 7-1: System Manager and Maestro Desktop Icons 
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7.3. CONFIGURING A SYSTEM 

The MVP System Manager utility software is used for both configuring a PC-based MVP server, and for 
controlling it.  To set up a new system and launch the server, follow the instructions below. 
 
1. Double-click the MVP System Manager icon on the desktop. 
 
2. Under the System menu select, “Add System”. This will launch the system configuration wizard. 
 
3. Follow the steps in the wizard to define the MVP system that the server will be controlling. 
 

The wizard will guide you through the following steps: 
 

1. Provide a name for the system. 
2. Select if SNMP, GPI, or VGPI preset loading will be used. 
3. Adjust the system properties. (Ensure you carefully read the description for each 

property). 
4. Define all of the input and output components in the system, packet routing hardware, 

and desktop control panels.  
 

 
Note:  Remember to add an IP address for each of the components. 

  
5. Define the PLINK interconnect for the system.  The setup can be visualized using the 

visualize links button. 
 
4. After set-up is complete, the system should appear on the main page of the System Manager. 
 

If changes need to be made to the configuration of the system, double-click on the system in the main 
page, or highlight the system and press the modify system button. 

 
5. Before proceeding, the PC MVP server must be unlocked.   
 

To unlock the server, click on the Server LOCKED button.  Enter the server key provided as shown in 
Figure 7-2, with dashes “-“.  After entering the key, the lock symbol will change and the server will be 
“UNLOCKED”. 

 

 

Figure 7-2:  Unlocking the Server 

 
6. To start the system, click on the Start System (GO) button.   
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The status window (lower pane) of the software will report the connection status of the server to the 
MVP hardware.  If there is a problem connecting to any of the hardware, an error message will be 
displayed here.  Use the status tab to view the hardware components’ network connection status to the 
MVP server.  See Figure 7-3. 

 

 

Figure 7-3: System Connection Status Window 

 
7. To stop a server, click the Stop System (STOP) button. 
 
8. To exit the System Manager, you must navigate to the System menu and then select Quit. 
   

 
Note:  If you use the windows “X” button, the program will only minimize to the 
tool tray, not exit. 

 

7.4. ENABLING THE MVP EMBEDDED SERVER 

1. Use the supplied ribbon cable to connect to Jumper J13 on the card edge of the output display 
card.   
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2. Set the Com Port settings for HyperTerminal to: 
 

Baud 115200 bps 
Parity no 
Data bits 8 
Stop bits 2 
Flow Control None 

 
3. Using HyperTerminal, select (2) On board Server Configuration. 

Figure 7-4: Main Menu 

4. Select (2) Enable Server.  Then select “s” to save and exit the menu. 

------------------------------------------------ 
|                   Main Menu                    
| 
|              (3000PPV 2.0.0rc40)               
| 
 -----------------------------------------------
- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Hardware Test Menu 
(7) Engineering/Debug 
 
(X) Exit 
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Figure 7-5: Onboard Server Configuration Menu 

 

 

CAUTION: Please note that only one display card should run the server in 
the system.  
 
If two display cards exist, only enable the first display card in the 
system; don’t enable the server on the second card. 

  
5. Reboot the frame.   
 
6. Verify that all the input and output cards in the system are connected to the server. 
 
7. Using HyperTerminal select (1) Display Connection Status from the Onboard Server 

Configuration menu. 
 
You should see messages similar to what is shown in Figure 7-6.  All of the cards that are configured in 
the system should be displayed, along with their IP addresses. Their status should be listed as 
CONNECTED. 

------------------------------------------------------
--- 
|               Onboard Server Configuration              
| 
|                     (3000PPV 2.5.1)                     
| 
 -----------------------------------------------------
---- 
 ------------------------------------------------ 
Onboard Server: Disabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> 
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Figure 7-6: Connection Status 

 
You can now start Maestro, connect to system, and then use the system normally.  
 
 

7.5. CONFIGURING AN EMBEDDED SERVER MVP  

The MVP System Configuration Tool software is used for configuring the embedded MVP server.  To 
setup a new system, follow the instructions below. 
 
1. Double-click the MVP System Configuration Tool icon on your desktop. 

 
2. Enter the display card’s IP address in the Onboard Server field. 
 

 

Figure 7-7: Entering the Display Card's IP Address 

 
3. Click the System Configuration tab. 

 

Name  IP    Status 
--------------------------------------- 
DC1  192.168.9.17  CONNECTED 
IC1  192.168.9.11  CONNECTED 
IC2  192.168.9.13  CONNECTED 
IC3  192.168.9.14  CONNECTED 
IC4  192.168.9.16  CONNECTED 
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4. Read the description for each of the system properties carefully, then select the properties you 
would like to enable for the server. 

 

 

Figure 7-8: System Configuration Screen 

 
5. Click the Hardware Setup tab.  

 
6. List all of the hardware components (input cards, output cards, and desktop control panels) in the MVP 

system by entering the component’s name, choosing the component’s type from the drop-down list, 
and entering the component’s IP address. 
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Figure 7-9:  Entering Hardware Components 

 
7. Click the PLINK Setup tab.  

 
8. List all of the PLINK interconnects in the system by selecting the card and output from the list, and 

then selecting the destination card and input port from the drop-down box at the bottom of the window. 
 

Use the Visualize Links button to review the hardware and PLINK assignments. 
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Figure 7-10: PLINK Setup Screen 

 
9. After completing setup, send the configuration to the MVP server by clicking the Send to Server 

button. 
 

7.6. ADDING A SYSTEM TO MAESTRO SOFTWARE 

1. Double click the “MVP Maestro” icon on your desktop. 
 

 

Figure 7-11: MVP Maestro Icon 

 
2. Once the software has loaded, a login dialog box will appear.  You must enter a username and 

password in order to gain access to the program. 
 
3. The default username is “admin”, with no password.  Type “admin” in the User Name field and press 

<ENTER>.  
 
4. If you are starting Maestro for the first time, there will not be any MVP systems present in the opening 

screen, an Add System form (as shown in Figure 7-12) will open up automatically after log-in. 
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Figure 7-12: Add System Form 

 
5. Enter a name for the system in the System Name field (e.g.: System 1). 
 
6. In the IP Address field, enter the IP address of the PC that the server (conductor) is running on.   
 

Note: If the server is running on the same PC as the Maestro client, enter 127.0.0.1.  This 
is a loop back address (i.e.: the server will query the PC for an IP address).   

 
7. Select the IP port number that was chosen during the System Configuration (9680 is default) in the IP 

Port field. 
 
Maestro will contact the server and read back all of the configuration files to determine the type of system 
it will control.  You will now have a System Icon on the System Manager page similar to the one shown in 
Figure 7-13.  
 

 

Figure 7-13: System Icon 
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7.7. CONNECTING TO THE SYSTEM 

1. Double-click on the System Icon.  This will take you to the Display Manager window. You should see a 
display icon for every output of the display card. 

 

 

Figure 7-14: Display Icons 

 
2. Press the Connect button at the top of the screen. 

 
 

 

Figure 7-15: Connect Button 

 
3. At this time you should see that the system is Online and a counter should start counting up. 
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4. To clear the system for the first time, perform a System reset by selecting Tools > Reset System. 
 
5. Double-click on one of the Display Icons to enter the Design Canvas Overview screen for that display 

output. 
 
6. Double-check the operation of the system by placing clocks and input windows on the display and 

verifying that they appear correctly. 
 
For more information on using the Maestro software, refer to the Maestro User Manual. 
 
 

7.8. MVP UPGRADE 

The MVP software is only available through a private FTP site; therefore you must contact Evertz 
customer service for software updates. 
 
 
To perform the upgrade: 
 
1. After obtaining the latest software from Evertz, run the software installer by double-clicking on the 

setup .exe file  
 

e.g.: mvp-setup-2.5.2.exe 
 
2. Follow the instructions provided by the installer.  
 

 
Note: You must install the Maestro software and the System Configuration Tool. 

 
3.  After completing the install you will have two icons on your desktop:  MVP Maestro and MVP System 

Configuration Tool. 



  
MVP User's Guide 

 

MVP SOFTWARE Revision 2.8.7 Page 7-13 

 

Figure 7-16: System Configuration and Maestro Icons 

 

7.9. CONFIGURING THE ALARMS 

7.9.1. Configuration of Alarms in Maestro 

1. Launch the Maestro application and ensure that a system is created in Maestro for the MVP.  Please 
note that the following screens refer to the VIP, however the MVP and VIP are configured in the same 
way and therefore the user can follow the same instructions in order to configure the MVP.   
 

 

Figure 7-17: Maestro System Manager 
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2. To access the Display Manager, double click on the desired system from the System Manager list.  
 

 

Figure 7-18: Maestro Display Manager 

 
3. To enter the Design Canvas Overview, double click the display that the alarm will appear on. 
 

 

Figure 7-19: 4x3 Display  
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4. To open the alarm, drag and drop a window onto the design canvas. Once the window is displayed, 

assign the appropriate source to be monitored.  
 

 

Figure 7-20: Object on Design Canvas  

 
5. To enter the interior design, double click on the video window.  
 
6. Select the Status tab and drag a fault label onto the video window. 
 
7. Double click on the fault label to edit the properties of the label.  
 

The text can be renamed to more accurately reflect the error/alarm.  For example, if the fault is 
triggered on a loss of video, the text can be changed to “Loss of Video”. 
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Figure 7-21: Maestro Fault Display 

 
8. From the right hand window pane navigate to the Fault Display section and expand the Fault Indicator 

Rules.  The Fault Indicator Rules enables the user to define the trigger of the error/alarm.  To set the 
trigger, place a check mark beside the appropriate trigger option in the Define Trigger window, such as 
Loss of Video as shown in Figure 7-22. Once the appropriate trigger is defined, select OK.   

 

 

Figure 7-22: Defining Trigger for Video 
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9. The setup of a preset with alarm monitoring is now complete. VLPro - C can be used to adjust the 

parameters of the error/alarm (see section 7.9.2). 
 

7.9.2. Adjusting Parameters for Alarms in VLPro – C 

1. To adjust the parameters for the alarms, launch the VLPro – C (Configuration Only) software and 
ensure that the card that you are configuring appears in the Navigation Tree. Also, ensure there is 
Ethernet communication with the card and the PC is running VLPro. 

 

 

Figure 7-23: VistaLINK® Navigation Tree 

 
2. Right click on the input that is to be configured (for example, Input 1 in Figure 7-23) and select 

View Configuration from the drop down menu.  Now VLPro will communicate to the card and 
retrieve the current status of the parameters.  
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Figure 7-24: Audio Control Tab 

 
3. The user will be required to set the parameters for the amount of frames of video loss before the 

alarm will trigger.  To configure this setting, select the appropriate input (for example, Input 1 in the 
Figure 7-25) and then select the Video Fault Definitions tab.  By default this parameter is set to 0 
frames, however this parameter has a value range of 0 to 900 frames.  The Video Loss Reset 
Duration is the amount of time after the fault has corrected that the label will be visible. Once all 
parameters have been set, ensure to apply the changes in order to send the new parameters to 
the card.  
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Figure 7-25: Video Fault Definitions Tab 

 
4. The faults/alarms have now been configured.  If there is a need to log or trap the alarms, the user 

will require the VLPro Server and Client software.  
 

7.9.3. Configuring the Traps 

1. To configure traps, launch the VLPro Server and Client.  
 

2. Connect the serial upgrade cable to the card edge. 
 

3. Select the SNMP Configuration option from the menu. 
 

4. Select option 1 from the SNMP Configuration menu and enter the IP Address of the server that will 
be collecting/logging the traps. Please note that the user can set more than one trap destination.  
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Figure 7-26: SNMP Configuration 

 
5. Once all the trap destinations have been set, select the (S) Save and exit option from the SNMP 

Configuration menu. The card must be rebooted for the new settings to take effect.  
 

6. Select the card that the logging of traps will occur on. To view the selected card configuration, right 
click and select View Configuration. Select the Audio Input Fault Traps tab and the Video Input 
Fault Traps to set the type of traps that VLPro will log.   To set the desired traps for logging, check 
or uncheck the appropriate item in the list of traps. Once complete, select the Apply button for the 
changes to take effect. 

  
7. The fault parameters can also be set with the VLPro Client.  Once a fault is triggered it will be 

logged in the VLPro Client. 
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8. CONFIGURING THE 3000DCP DESKTOP CONTROL PANEL 

Please note that this section assumes that the MVP Server has already been installed and configured. If 
you have not already done so, please install and configure the MVP Software using the instructions in 
section 7. 
 

8.1. FOR SYSTEMS USING ONBOARD SERVER 

8.1.1. Creating the System and Setting up the Hardware 

 
1. Launch the System Configuration Tool (SCT).  
 
2. Select the Profile Settings tab.   
 
3. Select “Onboard Server” as the System Type, and enter output card’s IP address in the text field 

marked “Enter the server address…” 
 
4. Press the Get from Server button at the top of the SCT to retrieve the system configuration for this 

system. 
 
5. Select the Hardware Setup tab.   
 
6. Add a DCP to the hardware list by filling in the name (e.g.: DCP1), type (DCP), and IP address fields.  

See Figure 8-1. 
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Figure 8-1: Adding DCP to Hardware List 

 
7. Press the Send to Server button at the top of the SCT window to send the new configuration to 

the server. 
 

8. Select the Transfer Scripts button located at the top of the SCT.   
 

9. In the Transfer Scripts window that appears: 
 

For Local File, browse to and select: 
  

C:\ProgramFiles\Evertz\mvp\conductor\sys01\samples\dcpbasic.vssl    
 

For Server File select DCP Config from the dropdown menu.   
 

10. Press the Send to Server button to send the DCP configuration file to the server, and then close 
the Transfer Scripts window. 
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Figure 8-2: Transfer Scripts Window 

 

8.1.2. Enabling the DCP Server 

1. Connect a serial cable to the serial port of the output display card running the server.  Refer to section 
3.20 for instructions on how to perform this task.  

 
--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                     (3000PPV 2.6.0)                     | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> > 1 

Figure 8-3: Onboard Server Configuration Menu 

 
2. Select (5) Enable dcpd and then select YES. 

 
3. Select (S) Save and Exit. 
 
4. Reboot the display card. 
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8.2. FOR SYSTEMS USING PC SERVER 

1. Launch the MVP System Manager and navigate to the System menu and then select Modify 
System.   

 
2. Select the Hardware Setup tab.   
 
3. Add a DCP to the Hardware list by filling out the name, type, and IP address fields.  See Figure 8-4 

below. 
 
4. When you have entered the information, click Add, and then OK.   
 
5. Select YES to restart the server. 
 
 

 

Figure 8-4: Adding the DCP to the Hardware List 

 
6. Click the Transfer Scripts button in the MVP System Manager.   
 

A Transfer Scripts window will appear.  
 
For Local File, browse to and select  

 
C:\Program Files\Evertz\mvp\conductor\sys01\samples\dcpbasic.vssl   
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For Server File, select DCP Config from the dropdown menu (see Figure 8-5 below) 
 

 

Figure 8-5: Transfer Scripts Window 

 
7. Press the Send to Server button to send the DCP configuration file to the server. 
 
8. Close the Transfer Scripts window.   
 
9. Stop and restart the server. 
 

8.3. FOR PC AND ONBOARD SERVER – DCP SETUP 

1. Press the Select and Setup buttons on the DCP at the same time to enter the setup menu.   
 
2. Ensure that the DCP has the correct IP address as entered in the Hardware Setup Table.   
 
3. Verify all network settings.  Use the arrow buttons and rotary knob to enter network information.  Also 

ensure that the DCP is connected to the same network as the MVP, and can be pinged from the PC 
running the Maestro application. 
 

It may take a few seconds in order for the DCP to connect.   
 
When it does, the dot-matrix display will go from displaying “No Clients Connected” to “Evertz 3000DCP 
DCPd@ xxx.xxx.xxx.xxx”. 

 
DCP presets are saved using the format “dnn-pnn”, where nn is the display number and preset button 
number.   
 
Use the Maestro software to save presets as a script (File > Save as script) using the described format.  
Maestro will automatically place the preset for the DCP in the correct location. 

 
Example: 

 
d01-p01, assigns the preset to display 1 preset button 1 
d01-p12, assigns the preset to display 1 preset button “shift” 2 (12) 
d04-p08, assigns the preset to display 4 preset button 8 
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8.4. UPGRADING THE 3000DCP  

The following are instructions on how to perform a firmware upgrade on the 3000DCP desktop control 
panel.  Please note that these are secondary methods to performing this upgrade, as it is normally 
completed in System Configuration Tool (Hardware Settings > Update). 
 
To use the serial method (baud rate = 115200, 8 data bits, N parity, 2 stop): 
 
1. Connect a serial port to the DB-9 serial connector on the back of the DCP. 

 
2. Hold down the Undo button and the Setup button while powering on the DCP. 

 
3. Using the serial terminal, hit CTRL-X at the prompt to put unit in upgrade mode. 

 
4. At the prompt type “upload”. 

 
5. Use the terminal software to send the new firmware file using X-modem. 

 
6. After the firmware has been transferred, power cycle the unit. 
 
 
To use the FTP method: 
 
1. Open a dos window. 

 
2. At the prompt, type “ftp xxx.xxx.xxx.xxxx” where the x’s represent the IP address of the DCP. 

 
3. Hit <ENTER> for user name, and password. 

 
4. Type “put filename.bin” at the ftp prompt, where “filename.bin” represents the released firmware for the 

device. 
 

5. After the file has been transferred successfully, type “quit”. 
 

6. Power cycle the DCP. 
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9. SETTING UP PRESET LOADS 

9.1. SETTING UP A GPI PRESET LOAD – OFFBOARD SERVER 

Please note that this procedure assumes an MVP Server has already been installed and configured.  If 
you have not already done so, please refer to section 7 for instructions on installing and configuring an 
MVP Server. 
  
These instructions also assume the default install location of MVP software. If you have installed the MVP 
software elsewhere, please substitute your install location wherever the default location is referenced 
below. 
 
Initial configuration of GPI presets requires the use of Windows Explorer and Notepad. GPI presets loads 
are configured through two files: actions.vssl and gpicfg.vssl 
 

9.1.1. The gpicfg.vssl File 

The gpicfg.vssl file maps actions to GPIs. These mapped actions are used to define what the gpi will do 
(e.g.: load a preset).  
 
The syntax for the gpicfg.vssl file can be broken down into three parts:   

  
Part 1: obj GPISource ("DC1")    
 

This defines where the GPIs are connected. When running the Offboard Server, this entry must 
be set to the name of first output card listed in the Hardware Setup tab of the Server 
Manager, and only the GPIs connected to that card may be used for preset loads. For all other 
output cards in the system, the GPIs will operate normally.  
  

Part 2: obj gpi(1)  
 

This defines the GPI that will trigger the action (i.e.: the preset load).  
  

Part 3: { action = "presetload" }   
 

The action allows the system to link a GPI to an operation (i.e.: a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file, the second 
configuration file. The actions.vssl file will define that operation.  

 
Example of a configured gpicfg.vssl file  

  
                    obj GPISource ("DC1") {  
              obj gpi(1) { action = "presetload" }  
               }  

 
This configuration maps GPI 1 for DC1 to an action called “preset load”. 
 



 
MVP User's Guide 
 

Page 9-2 Revision 2.8.7 PRESET LOADS 

9.1.2. The actions.vssl File 

The actions.vssl file maps actions to a function. These mapped actions are used to define what the action 
will do (e.g: load a preset).   
 
The syntax for the actions.vssl file may be broken down into three parts:   

  
Part 1: obj ActRunScript("presetload")  

 This defines the name of the action. The name is referenced by gpicfg.vssl  
  

Part 2: script = "preset1.vssl"  
This defines the name of the script file (preset) that will be triggered by the action. The script 
file is created in Maestro during design mode.  
 

Part 3: display = 1  
This defines the output that the preset will be loaded on. This is a logical output number. 
Example DC1, 1,2,3,4, DC2, 5,6,7,8  
 

Example of a configured actions.vssl file  
  
                   obj ActRunScript("presetload") {  
                   script = "preset1.vssl"  
                   display = 1  
                   }  

     
This configuration maps the action “presetload” to the preset “preset1.vssl” which will be loaded on the first 
output of the first display card in the system.                  
  

9.1.3. How to Set Up a GPI Preset Load (Offboard Server) 

Follow the instructions below to set up a preset load. 
 
Part 1: Editing the gpicfg.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\ Conductor \Samples 

 
2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program From List, 

depending on your operating system.  
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Figure 9-1: Open With Window 

 
3. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 

of file and then click OK. 
 

Note:  When using Notepad, make sure that Word Wrap is disabled. A checkmark appears 
next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word Wrap in 
the Format menu.  This will disable Word Wrap, removing the checkmark. 

  

   

 Figure 9-2: Word Wrap 

 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 

drop-down list.  
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 Figure 9-3: Save As 

 
Part 2: Editing the actions.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\ Conductor \Samples  

 
2. Double-click the file called actions.vssl, and select Open With or Select Program from List, 

depending on your operating system.  
  

  

Figure 9-4: Open With 
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3. Select Notepad, and also click the checkbox beside Always use the selected program to open this 
kind of file and then click OK. 

  
Note:  When using Notepad, make sure that word wrap is disabled. A checkmark appears 

next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word Wrap in 
the Format menu.  This will disable Word Wrap, removing the checkmark. 

 
  

 

 Figure 9-5: Word Wrap 

 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 

drop-down list. 
  

 

 Figure 9-6: Save As 

  
Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the server.  
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Part 3: Transferring the Gpicfg.vssl and Actions.vssl Files (Offboard Server) 
  
1.  Launch the MVP System Manager, and select the system that will be using GPI based preset loads.   

  

    

 Figure 9-7: MVP System Manager 

 
2.  Click on Transfer Scripts, which will launch the window below. 

  

   

Figure 9-8: Transfer Scripts 
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3.  Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples  

 
4.  Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
  
5.  From the Server File drop-down box, select Actions.  
  
 

   

Figure 9-9: Transfer Scripts 

  
6.  Click on Send to Server. The file actions.vssl will be sent to the server. 
  

7.  Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples    

  
8.  Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 
  
9.  From the Server File drop-down box, select GPI Config. 

  

   

 Figure 9-10: Transfer Scripts 
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10. Click on Send to Server. The file gpicfg.vssl will be sent to the server. 
 
The last step is to enable the GPId daemon. 
 
 
Part 4: Enabling GPId Daemon Using an Offboard Server 
  
The ability to load presets on a display is controlled by a daemon called GPId that runs in the MVP Server 
Manager.  
 
This daemon is only used to load presets on a display, it is not required with normal GPI operation.   
  
1. Launch the MVP System Manager  

  
 

   

 Figure 9-11: MVP System Manager 

 
2. Click on the Modify System button.  
 
3. Select the Global Setting Tab, and click the check box labeled Use GPI.  
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 Figure 9-12: Global Settings 

 
4.  When you have made these selections, click on OK to save the changes. 

  
The system will then display the following message:  

  
 

   
  

6.  Click Yes to restart the server. 
  
When the server has restarted, GPIs can be used to load the defined presets in the gpicfg.vssl and 
actions.vssl files. Please refer to the Maestro manual for instructions on how to create the presets. 
 

9.2. SETTING UP A GPI PRESET LOAD - ONBOARD SERVER 

Please note that this procedure assumes an MVP Server has already been installed and configured.  If 
you have not already done so, please refer to PLACEHOLDER for instructions on installing and 
configuring an MVP Server. 
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These instructions also assume the default install location of MVP software. If you have installed the MVP 
software elsewhere, please substitute your install location wherever the default location is referenced 
below. 
 
Initial configurations of GPI preset loads require the use of Windows Explorer and Notepad. GPI preset 
loads are configured through two files: actions.vssl and gpicfg.vssl 
 

9.2.1. The gpicfg.vssl File 

The gpicfg.vssl file maps actions to GPIs. These mapped actions are used to define what the gpi will do 
(e.g: load a preset).  
 
The syntax for the gpicfg.vssl file can be broken down into three parts:   

  
Part 1: obj GPISource ("DC1")    
 

This defines where the GPIs are connected. When running the Onboard Server, the name of 
the output card must be set to (“Local”), and only the GPIs connected to that card may be used 
for preset loads. For all other output cards in the system, the GPIs will operate normally.  
  

Part 2: obj gpi(1)  
 

This defines the GPI that will trigger the action (i.e.: the preset load).  
  

Part 3: { action = "presetload" }   
 

The action allows the system to link a GPI to an operation (i.e.: a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file, the second 
configuration file. The actions.vssl file will define that operation.  

 
Example of a configured gpicfg.vssl file:  

  
                    obj GPISource ("DC1") {  
              obj gpi(1) { action = "presetload" }  
               }  

 
This configuration maps GPI 1 for DC1 to an action called “preset load”. 
 

9.2.2. The actions.vssl File 

The actions.vssl file maps actions to a function. These mapped actions are used to define what action will 
be executed (e.g.: load a preset).  
 
The syntax for the actions.vssl file may be broken down into three parts:   

  
Part 1: obj ActRunScript("presetload")  
 

 This defines the name of the action. The name is referenced by gpicfg.vssl  
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Part 2: script = "preset1.vssl"  
 

This defines the name of the script file (preset) that will be triggered by the action. The script 
file is created in Maestro during design mode.  
 

Part 3: display = 1  
 

This defines the output that the preset will be loaded on. This is a logical output number. 
Example DC1, 1,2,3,4, DC2, 5,6,7,8  
 

Example of a configured actions.vssl file:  
  
                   obj ActRunScript("presetload") {  
                   script = "preset1.vssl"  
                   display = 1  
                   }  

     
This configuration maps the action “presetload” to the preset “preset1.vssl” which will be loaded on the first 
output of the first display card in the system.                  
  

9.2.3. How to Set Up a GPI Preset Load 

Follow the instructions below to set up a preset load. 
 
 
Part 1: Editing the gpicfg.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
 

C:\Program Files\ Evertz\ MVP\ Conductor \Samples 
 
2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program From List, 

depending on your operating system.  
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3. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 

of file and then click the OK button. 
 

 

Note:  When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word 
Wrap in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 
  

   
  

 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 

drop-down list.  
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Part 2: Editing the actions.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\ Conductor \Samples  

 
2. Double-click the file called actions.vssl, and select Open With or Select Program from List, 

depending on your operating system.  
  

  
  
3. Select Notepad, and also click the checkbox beside Always use the selected program to open this 

kind of file and then click the OK button.                                                                                                     
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 

Note: When using Notepad, make sure that word wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word 
Wrap in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 

 
  

4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 
drop-down list. 
  

 
  
Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the server. 
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Part 3:  Verifying Communication with the Onboard Server 
 
1. Launch the System Configuration Tool and select the System Configuration tab.   
 
2. Select System Type: Onboard Server and enter the IP address of the Onboard Server card in the 

text field as depicted below. 
 

 
 
 
3. Click on Get from Server at the top of the System Configuration Tool to retrieve configuration and 

verify communication with the Onboard Server. 
 
Part 4: Transferring the Gpicfg.vssl and Actions.vssl Files Using an Onboard Server 
 
1. Click on Transfer Scripts, which will cause the window below to be displayed. 
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2. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples 
 

3. Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
 

4. From the Server File drop-down box, select Actions. 
 

 
 
5. Click on Send to Server. The file actions.vssl will be sent to the server. 

 

6. Click on the  box to open a browse window. Browse to where gpicfg.vssl and actions.vssl files were 
saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 
 

7. Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 
 
8. From the Server File drop-down box, select GPI Config. 
 

 
 

9. Click on “Send to Server”. The file gpicfg.vssl will be sent to the server. 
 
The last step is to enable the GPId daemon. 
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Part 5: Enabling GPId Daemon on the Onboard Server 
 
The ability to load presets on a display is controlled by a daemon running on the server output card called 
GPId.  
 
This daemon is only used to load presets on a display, it is not required with normal GPI operation.  
 

 
The next few steps require a PC with HyperTerminal, a serial port, a serial cable, and 
a serial upgrade cable.  

 
1. Attach the serial upgrade cable to the server output card and launch HyperTerminal as outlined in the 

MVP Manual. 
 
2. Once connected with HyperTerminal, hit <ENTER> to display the serial menu of the server output 

card. 
 

 -------------------------------------------------------- 
|                        Main Menu                       | 
|                     (3000PPV 2.6.1)                    | 
 -------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Display Wall Test 
(7) Hardware Test Menu 
(8) Engineering/Debug 
 
(X) Exit 

Figure 9-13: Main Menu 
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3. Select option (2) Onboard Server Configuration 
 
 -------------------------------------------------------- 
|               Onboard Server Configuration             | 
|                     (3000PPV 2.6.1)                    | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 

Figure 9-14: Onboard Server Configuration Menu 

4. Select (3) Enable gpid to enable the daemon required to load presets through GPIs. 
 

 -------------------------------------------------------- 
|               Onboard Server Configuration             | 
|                     (3000PPV 2.6.1)                    | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Enabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> s 
Saving changes.. 
Please reboot for changes to take effect 

 
5. Select (S) Save and Exit to save the changes. Reboot the server output card for the changes to take 

effect. 
 
When the card has been re-booted, GPIs may be used to load the defined presets in the gpicfg.vssl and 
actions.vssl files. Please refer to the Maestro manual for more information on how to create the presets. 
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9.3. SETTING UP A VGPI PRESET LOAD – OFFBOARD SERVER 

VGPIs are virtual GPIs sent by a 7000MVP-PTX or a third-party device adhering to the VGPI 
protocol format.   
 
Initial configurations of VGPI preset loads require the use of Windows Explorer and Notepad.  
VGPI preset loads are configured through two files: actions.vssl and picfg.vssl. 
 
Please note that this procedure assumes the MVP Server has already been installed and configured.   
 
These instructions also assume the default install location of MVP software.  If you have chosen an 
alternate install location, please substitute your install location wherever the default location is reference 
below. 
 

9.3.1. The gpicfg.vssl File 

The gpicfg.vssl file maps actions to GPIs. These mapped actions are used to define what the gpi will do.  
 
The syntax for the gpicfg.vssl file can be broken down into three parts:  
 

Part 1: obj GPISource ("DC1"):  
 

This defines where the VGPIs are connected. When running the Offboard Server, this entry 
must be set to the name of first output card listed in the Hardware Setup tab of the Server 
Manager, and only the VGPIs connected to that card maybe used for preset loads. For all 
other output cards in the system, the VGPIs will operate normally. 

 
Part 2: obj vgpi(1): 
 

This defines the VGPI that will trigger the action, i.e. the preset load. 
 
 

Part 3: { action = "presetload" } 
 

This action allows the system to link a VGPI to an operation (a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file (the second 
configuration file). The actions.vssl file will then define that operation. 

 
Example of a Configured “gpicfg.vssl” File 
 

obj GPISource ("DC1") { 
obj vgpi(1) { action = "presetload" } 
} 

    
 
This configuration maps VGPI 1 for DC1 to an action called “preset load”. 
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9.3.2. The actions.vssl File 

The actions.vssl file maps actions to a function. These mapped actions are used to define what the action 
will do (e.g.: load a preset). 
 
The syntax for the actions.vssl file can be broken down into three parts:  

 
Part 1: obj ActRunScript("presetload") 
 

This defines the name of the action. The name is referenced by gpicfg.vssl. 
 

Part 2: script = "preset1.vssl" 
 

This defines the name of the script file (preset) that will be triggered by the action. The 
script file is created in Maestro during design mode. 

 
Part 3. display = 1 
 

This defines the output that the preset will be loaded on. This is a logical output number 
(e.g.: DC1 - 1,2,3,4; DC2 - 5,6,7,8) 

 
Example of a configured actions.vssl file 
 

obj ActRunScript("presetload") { 
script = "preset1.vssl" 
display = 1 
} 

    
This configuration maps the action “presetload” to the preset “preset1.vssl”, which will be loaded on 
the first output of the first display card in the system.     
 

9.3.3. How to Set Up a VGPI Preset Load             

Part 1:  Editing the gpicfg File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\ Conductor \Samples 

 
2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program from List, 

depending on your operating system. 
 



  
MVP User's Guide 

 

PRESET LOADS Revision 2.8.7 Page 9-21 

 
 

3. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 
of file and then click the OK button.                                                                                                    

 

 

Note:  When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 
 

 
 

4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 
drop-down list.  
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Part 2: Editing the actions.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\Conductor\Samples 

 
2. Double-click the actions.vssl file, and select Open With or Select Program from List, depending on 

your operating system. 
 

 
 
3. Select Notepad, and also click the checkbox beside Always use the selected program to open this 

kind of file and the click the OK button.                                                                                                    
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 

Note: When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 

 
  
 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 

drop-down list.  
 

 
 

Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the server 
 
 
Part 3: Transferring the Gpicfg.vssl and Actions.vssl Files 
 
1. Launch the MVP System Manager, and select the system that will be using VGPI based preset loads.  
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2. Click on Transfer Scripts, which will launch the window below. 

 

 
 

3. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples 
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4. Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
 

5. Select Server File, click on Actions. 
 

 
 
6. Click on Send to Server. The file actions.vssl will be sent to the server. 

7. Click on the  button to open a browse window. Browse to where gpicfg.vssl and actions.vssl files 
were saved.  

 
 The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 
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8. Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 

 
9. Select Server File, and then click on GPI Config. 

 

 
 

10. Click on Send to Server. The file gpicfg.vssl will be sent to the server. 
 

The last step is to enable the VGPId daemon. 
 
 
Part 4: Enabling the VGPId Daemon 
 
The ability to load presets on a display is controlled by a daemon called VGPId that runs in the 
MVP Server Manager.  
 
This daemon is only used to load presets on a display. It is not required with normal VGPI operation.  
 
1. Launch the MVP System Manager. 
 
2. Click on Modify System button. 
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3. Select the Global Setting tab, and click the checkbox beside Use VGPI. 
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4. When you have completed the selection, click on OK to save the changes. 
 

 The system will then display the following message: 
 

 
 

5. Click Yes to restart the server. 
 

When the server has been restarted, VGPIs may be used to load the defined presets in the gpicfg.vssl 
and actions.vssl files. Please refer to the Maestro manual for information on how to create the presets 
 
 

9.4. SETTING UP A VGPI PRESET LOAD – ONBOARD SERVER 

VGPIs are virtual GPIs sent by a 7000MVP-PTX or a third party device adhering to the VGPI 
protocol format.  
 
Initial configurations of VGPI preset loads require the use of Windows Explorer and Notepad. VGPI preset 
loads are configured through two files: actions.vssl and gpicfg.vssl 

 
Please note that this procedure assumes the MVP Server has already been installed and configured. If 
you have not already done so, please refer to sections 7.2 and 7.3 for further information. 
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These instructions also assume the default install location of MVP software.  If you have chosen an 
alternate install location, please substitute your install location wherever the default location is referenced 
below.  
 

9.4.1. The gpicfg.vssl File 

The gpicfg.vssl file maps actions to VGPIs. These mapped actions are used to define what the VGPI will 
do (e.g.: load a preset). 
 
The syntax for the gpicfg.vssl file can be broken down into three parts:  

 
Part 1: obj GPISource ("Local")  

This defines where the VGPIs are connected. With an onboard server, this entry must be set to 
(“Local”), and only the VGPIs connected to the onboard server card can be used for the preset 
load. For onboard systems with two output cards, the VGPIs will operate normally for the card not 
running the server. 

 
Part 2: obj vgpi(1) 

This defines the VGPI that will trigger the action (the preset load). 
 

Part 3: { action = "presetload" } 
The action allows the system to link a VGPI to an operation (i.e.: a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file (the second 
configuration file). The actions.vssl file then will define that operation. 

 
Example of a configured gpicfg.vssl file 

 
                    obj GPISource ("Local") { 
              obj vgpi(1) { action = "presetload" } 
               } 

    
This configuration maps VGPI 1 for an onboard server to an action called “preset load”. 
 

9.4.2. The actions.vssl File 

The actions.vssl file maps actions to a function. These mapped actions are used to define what the action 
will do (e.g.: load a preset). 
 
The syntax for the actions.vssl file can be broken down into three parts:  

 
Part 1: obj ActRunScript("presetload") 

This defines the name of the action. The name is referenced by gpicfg.vssl 
 

Part 2: script = "preset1.vssl" 
This defines the name of the script file (preset) that will be triggered by the action. The script file is 
created in Maestro during design. 

 
Part 3: display = 1 

This defines the output that the preset will be loaded on. This is a logical output number. 
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Example of a configured actions.vssl file 

 
obj ActRunScript("presetload") { 
script = "preset1.vssl" 
display = 1 
} 

    
This configuration maps the action “presetload” to the preset “preset1.vssl”, which will be loaded on the 
first output of the first display card in the system.                 
 

9.4.3. How to Set Up a VGPI Preset Load 

Follow the instructions below to set up a VGPI preset load. 
 
Part 1:  Editing the gpicfg.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\ Conductor \Samples 

 
2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program from List, 

depending on your operating system. 
 

 
 

3. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 
of file and then click OK button.                                                                                                    
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 

Note: When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu and remove the checkmark. 

 

 
 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from 

the drop-down list.  
 
 

 
 
Part 2: Editing the actions.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of MVP software:  
C:\Program Files\ Evertz\ MVP\Conductor\Samples 

 
2. Double-click the actions.vssl file, and select Open With or Select Program from List, depending on 

your operating system. 
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3. Select Notepad, and also click the checkbox beside Always use the selected program to open this 

kind of file and then click OK button.        
                                                                                             

 

Note: When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu and remove the checkmark. 

 

 
  
 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 

drop-down list.  
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Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the 
server 
 
 
Part 3:  Verifying Communication with the Onboard Server 
 
1. Launch the System Configuration Tool and select the System Configuration tab.   
 
2. Select System Type: Onboard Server. Enter the IP address of the onboard server card in the text 

field as depicted below. 
 

 
 
 
3. Click on Get from Server at the top of the System Configuration Tool to retrieve configuration and 

verify communication with the Onboard Server. 
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Part 4: Transferring the Gpicfg.vssl and Actions.vssl Files Using an Onboard Server 
 
1. Click on Transfer Scripts, which will cause the window below to be displayed. 

 

 
 

2. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 

 
3. Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
 
4. From the Server File drop-down menu, select Actions. 
 

 
 
5. Click on Send to Server. The file actions.vssl will be sent to the server. 

 

6. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  
 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 

 
7. Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 

 
8. From the Server File drop-down menu, select GPI Config. 
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9. Click on Send to Server. The file gpicfg.vssl will be sent to the server. 
 

The last step is to enable the VGPId daemon 
 
Part 5: Enabling VGPId Daemon on the Onboard Server 
 
The ability to load presets on a display is controlled by a daemon called “VGPId”, running on the server 
output card.  
 
This daemon is only used to load presets on a display. It is not required with normal VGPI operation.  
 

 
The next few steps require a PC with HyperTerminal, a serial port, a serial cable, and 
a serial upgrade cable.  

 
1. Attach the serial upgrade cable to the server output card and launch HyperTerminal as outlined in the 

MVP Manual. 
 
2. Once connected with HyperTerminal, hit <ENTER> to display the serial menu of the server output 

card. 
 

--------------------------------------------------------- 
|                        Main Menu                       | 
|                     (3000PPV 2.6.1)                    | 
--------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Display Wall Test 
(7) Hardware Test Menu 
(8) Engineering/Debug 
 
(X) Exit 

 
3. Select (2) Onboard Server Configuration. 
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--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                     (3000PPV 2.6.1)                     | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 

 
4. Select (3) Enable vgpid to enable the daemon required to load presets through VGPIs. 
 

--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                     (3000PPV 2.6.1)                     | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Enabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> s 
Saving changes.. 
Please reboot for changes to take effect 

 
5. Select (S) Save and Exit to save the changes. Reboot the server output card for the changes to take 

effect. 
 
When the card has been re-booted, VGPIs may be used to load the defined presets in the gpicfg.vssl 
and actions.vssl files. Please refer to the Maestro manual for instructions on how to create the presets. 
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10. SETTING UP PROTOCOLS 

Sections 10.1 to 10.4 explain how to set up the following protocols on the MVP system: 
 

• Image Video Protocol 
• TSL Protocol 
• X-Y Protocol 
• ASCII Protocol 

 
Only set up the protocols that are relevant to your system.   
 

10.1. SETTING UP MVP TO WORK WITH IMAGE VIDEO PROTOCOL 

1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 
positions on the auxiliary daughter card of the display card.   

 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 

This is performed via the upgrade serial port on the front of the card.   
 
4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 
Ensure the settings match those listed below: 

 
------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:      115200 
Data Bits:           8 
Parity:           None 
Stop Bits:           2 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-1: Auxiliary Port Setup Menu 

 
5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for Image 

Video protocol operation. 
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------------------------------------------------ 
|          Under Monitor Display Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     Image Video 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-2: Under Monitor Display Setup 

 
6. Wire the serial connection from the router/switcher to the auxiliary serial port of the MVP.   
 
7. Power-cycle the MVP frame. 
 
8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
9. In Mode Settings > Mode > Function, select Protocol ID from the drop-down box. 
 
10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the MVP receives a command from the router/switcher it will now be displayed on the output 
display.  
 

10.2. SETTING UP MVP TO WORK WITH TSL PROTOCOL 

1. Select RS-422 serial operation by setting jumpers J33 and J34 to this position on the auxiliary 
daughter card on the display card.   

 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 

This is performed via the upgrade serial port on the front of the card.   
 
4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 



  
MVP User's Guide 

 

PROTOCOL SETUP Revision 2.8.7 Page 10-3 

Ensure the settings match those listed below: 

Figure 10-3: Auxiliary Serial Port Settings 

 
5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for TSL 

protocol operation.   
 

Ensure the settings match those listed below: 

Figure 10-4: Under Monitor Display Setup Settings 

 
6. Wire the serial connection from the router/switcher to the auxiliary serial port of the MVP, located on 

the 3000BHP-AUX breakout panel.   
 

The 3000BHP-AUX is connected via the SCSI cable to the back of the display card in the MVP frame.    
 

------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:  38400 
Data Bits:  8 
Parity:           even 
Stop Bits:  1 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 
 

------------------------------------------------ 
|          Under Monitor Display Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     TSL 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 
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Connect the device providing the TSL data to the MVP 3000BHP-AUX as follows: 
 

TSL 
Source 

MVP 
3000BHP-AUX 

function Pin # Label 
GND 4  GND 
Tx+ 6 CTS 
Tx- 8 RX 

 
7. Power-cycle the MVP frame. 
 
8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
9. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
 
10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the MVP receives a command from the router/switcher it will now be displayed on the output 
display. 
 

10.3. SETTING UP MVP TO WORK WITH X-Y PROTOCOL 

Use the following set of instructions to configure the MVP to use the X-YI protocol. 
 

10.3.1. Creating the Text Files 

1. Create two text files named “router_src.cfg” and “router_dst.cfg”, and save both files to the compact 
flash card on the display card(s) in the MVP system.  

 
Please use the following example to create these two files: 

 
router_src.cfg 
 

#  src id   string 
0 “name 1” 
1 “name 2”  
2 “name 3” 
3 “name 4” 

 
Example: 
Sample router_src.cfg file: 

0 name1 
1 name2 
2 name3 
3 name4 
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router_dst.cfg 
 

# umd protocol id dst id 
0 1 
1 2 
2 3 

Figure 10-5: Sample Text Files 

Example: 
Sample router_dst.cfg file: 
 0 1 

1 2 
 2 3 
  
2. FTP both files to the compact flash cards of all display cards in the system: 

 
 C:\ftp “ip address of display card” 
 ftp>put router_src.cfg 
 ftp>put router_dst.cfg 
 ftp>quit 

 

10.3.2. Setting Up the Display Card(s) 

1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 
positions on the auxiliary daughter card of the display card.   

 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 
4. This is performed via the upgrade serial port on the front of the card.   
 
5. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   
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Ensure the settings match those listed below: 
 

------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:        9600 
Data Bits:           8 
Parity:           None 
Stop Bits:           1 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-6: Auxiliary Serial Port Setup 

 
6. Select (4) Under Monitor Display Setup from the main menu to set up the display card for XY 

Integrator protocol operation. 
 

------------------------------------------------ 
|          Under Monitor Display Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     XY Integrator 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-7: Setting up XY Integrator Protocol Operation 

 
7. Wire the serial connection from the router/switcher to the auxiliary serial port of the MVP.  Refer to the 

MVP manual for details on this procedure. 
 
8. Power-cycle the MVP frame. 
 
9. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
10. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
 
11. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
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When the MVP receives a command from the router/switcher it will now be displayed on the output 
display.  
 
The command that we expect to see is as follows: 
 

S:02,0   = 02:  level 0, destination 2 
 = ,1:  source 1 

Figure 10-8: Command Displayed on the Output Display 

 
Therefore, using the above files as an example – we would display at UMD protocol id 1, the text string 
“name 2”  
 

10.4. SETTING UP MVP TO WORK WITH ASCII PROTOCOL 

10.4.1. Creating the Text File 

1. Create a text file named “router.cfg” and save it to the compact flash on the display card.  
 

Use the following example to setup the file: 
 

# Input id String 
0      Source 0 
1      Source 1 
2      Source 2 
3      Evertz MVP 

 
Sample: 

0 Source0 
1 Source1 
2 Source2 
3 EvertzMVP 

 
 
2. FTP the file to the compact flash cards of all display cards in the system: 

 
 C:\ftp “IP address of display card” 
 ftp>put router.cfg 
 ftp>quit 

 

10.4.2. Setting Up the Display Card(s) 

1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 
positions on the auxiliary daughter card of the display card.   

 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
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This is performed via the upgrade serial port on the front of the card.   
 
4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 
Ensure the settings match those listed below: 

 
------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:      115200 
Data Bits:           8 
Parity:           None 
Stop Bits:           2 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-9: Auxiliary Serial Port Setup Menu 

 
 

5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for ASCII 
protocol operation. 

 
------------------------------------------------ 
|          Under Monitor Display Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     Philips ASCII 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 10-10: Under Monitor Display Setup Menu 

 
6. Wire the serial connection from the router/switcher to the auxiliary serial port of the MVP.  
 
7. Power-cycle the MVP frame. 
 
8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
9. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
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10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the MVP receives a command from the router/switcher it will now be displayed on the output 
display.  
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11. CREATING A REDUNDANT BACKUP OF AN OUTPUT CARD  

Creating a redundant back-up of identical output cards allows you to hot-swap output cards quickly and 
easily, allowing the system to return to its working state. 
 

 

 
CAUTION: Redundant back-up cards must be kept on the shelf and not in the frame.  
Because both cards have the same IP address, leaving the card in the frame could 
cause system instability. 

 
Complete the following steps using the Primary Output Card: 
 
 
Part 1: Obtaining the Server Configurations 
 
1. Use the RS-232/422 connection to the output card with HyperTerminal (or preferred RS-232/422 

client). 
 
2. Make note of: 

• IP address 
• UMD settings (Protocol, type, etc) 

 
3. Launch the System Configuration tool. 
 
4. Enter the Primary Output Card’s IP address. 
 
5. Click the Get From Server button. 
 
6. Click the Transfer Scripts button. 
 

7. Click on the  button to browse to the desired save location for the server configurations. 
 

Note:  These files will be .vssl files. 
 
8. Repeat steps 5-7 for each type being used. 
 
9. When finished, do not close this program, as it will store these settings for the output card. 

 
 

Part 2: Retrieving Scripts Saved on the Output Card 
 
1. Open a DOS window by selecting Start > Run, and typing “cmd”. 
 
2. In the DOS window that appears, type “ftp”, followed by the IP address of the output card that is 

running the server and click <ENTER>. 
 
3. When prompted for a username and password, press <ENTER> for both. 
 
4. Type “cd server/scripts” 



 
MVP User's Guide 
 

Page 11-2 Revision 2.8.7 REDUNDANT BACKUP CARDS 

5. Type “dir”. 
 
6. Type “get”, followed by the filename and location where you want to save these scripts.  
 

For example: 
 

get sample.vssl c:\sample.vssl 
 
7. Repeat steps 4-6 for each script. 
 
8. When finished, type “bye” to close the session. 
 
 
Now remove the primary output card from the MVP and insert the redundant output card. 
 
Complete the following steps using the Redundant Output Card: 
 
 
Part 3:  Setting Up the Redundant Output Card 
 
1. Use the RS-232/422 connection to output card with HyperTerminal (or preferred RS-232/422 client). 
 
2. Set the card’s IP address to the same one as the primary output card.   
 
3. Set UMD protocol, speed, etc. the same as was used for the primary output card. 
 
4. In DOS command prompt, type following:  

 
arp –d <IP address of Primary Output Card (that was removed from the frame)>  

 
e.g.: arp –d 192.168.9.50  
 

This will clear the MAC address settings from windows so SCT can connect to the new card even 
though the IP addresses are the same. 
 
 

Part 4: Sending Server Settings to Redundant Output Card 
 

1. Using the System Configuration Tool, send the server settings to the Redundant Output Card. 
 

These settings are:  
• types of cards in system  
• plink setup 
• general overall system settings   
 

2. Click on the Transfer Scripts button to transfer scripts such as action, gpi, etc., to the redundant 
output card. 

 

 
Note: These scripts will be the ones that you saved from the Primary Output 
card earlier. 
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Part 5:  Completing Set Up of Redundant Output Card 
 

1. Start Maestro and connect to the system.   
 

2. Select Tools > System Configuration. 
 

3. Select the Output Card. 
 
4. Click the Resolution tab. 
 
5. Select the appropriate resolution from your application. 
 
6. Click Apply. 
 
7. Right click on the display and choose Load Preset. When the preset has been loaded, click on File> 

Save As Script.  
 

This will ensure the “server/scripts” dir is created on the Redundant Output Card.  You can later delete 
this test script when using DOS FTP.  

 
8. Using DOS FTP, log into the MVP (which will use the same IP address as the output card) and upload 

the scripts that you have downloaded and saved to your hard drive from the Primary Output card to the 
location “server/scripts”. 

 
For example: 
 

put c:\sample.vssl 
 
9. Power-cycle the MVP to ensure that all the new settings on Redundant Output Card load. 

 
10. Test the system and check that all functions are working. 
 
You can now hot-swap cards and have the MVP return to its working state. 
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12. ENABLING CLOSED CAPTIONING DECODE 

This section requires that a configuration of the embedded MVP server has been uploaded and is running. 
If you have not already completed this configuration, please complete the steps detailed in section 7 prior 
to attempting the procedure below. 
 
Also before starting this procedure, make sure that the current MVP layouts (presets) are available. Before 
rebooting the MVP, be sure to Save System Settings in Maestro to ensure that the current layouts are re-
loaded after the MVP system has been rebooted.  

 
To set up the current system to support Closed Captioning Decode, follow the instructions below. 
 

12.1. PART 1: CHANGING THE SERVER SETTINGS 

1. Double-click the MVP System Configuration Tool icon on the desktop. 
 

2. In the Profile Settings tab, enter the IP address of the display card in the system on which the 
embedded MVP server is running. 

 
 

 

Figure 12-1: Onboard Server IP Address 

 
3. Click the Get from Server button.  This will connect to the server and retrieve the current system 

settings. 
 

4. Select the Hardware Setup tab. 
 

5. Highlight the input card that will be used to decode the Closed Captioning, and then click on the 
Properties button. 
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Figure 12-2: Hardware Settings 

 

 

Figure 12-3: Properties 

 
6. In the Properties window, select the Data Services Tab. 
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12.2. PART 2: CONFIGURING THE CLOSED CAPTIONING PROPERTIES 

There are subtle differences depending on whether you are using 608 closed captioning, 708 closed 
captioning, or Teletext (the European version of closed captioning).  Only one closed captioning mode is 
supported on the input card at a time. The card is not capable of mixing 608, 708, or Teletext captioning.  
 

12.2.1. 608 Closed Captioning Decode 

608 closed captioning is available for the SN, SNX, HSN, and OVN models. 
 

 

Figure 12-4: 608 Properties 

 
1. Select the input for which Closed Captioning decode is required. 

 
2. Select the Closed Captioning Decoder mode, CC1-CC4. 

 
3. When you have completed the above steps, click OK. 
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12.2.2. 708 Closed Caption Decode 

708 closed caption decode is available only on the HSN model. 
 

 

Figure 12-5: 708 Properties 

 
1. Select the input for which Closed Captioning decode is required. 

 
2. Select the Closed Captioning Decoder mode (708 SVC 1- 17). 

 
3. Select the 608/708 Font Size (720 with 720p video and 1080 with 1080i).  
 

 
Note:  The input card is not capable of supporting both 720p and 1080i 
captioning at the same time. 

 
4. When you have completed the above steps, click OK. 
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12.2.3. Teletext 

Teletext is available for the OVSNX and OVHSN models. 
 

 

Figure 12-6: Teletext Properties 

 
1. Select the input for which Teletext decode is required. 

 
2. Enable Teletext Decode. 

 
3. Select Teletext as the Captioning Standard. 

 
4. When you have completed the above steps, click OK. 
 
For the closed captioning/Teletext settings to be applied to the server, the settings must be sent to the 
server and the server must be restarted. 
 

12.3. PART 3: SENDING THE SETTINGS TO THE SERVER 

1. To transfer the changed settings to the server, click on the Send to Server button at the top of the 
main window. This will send all the changes to the server, overwriting the old settings. 

 
2. When the settings have been transferred, reboot the server so the settings take effect. 
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12.4. PART 4: STARTING MAESTRO AND ENABLING CLOSED CAPTIONING DECODE 

1. Double click the Launch Maestro Design Tool icon on your desktop. 
 

 
 The MVP Maestro Design splash screen will appear briefly as the software loads. 
 
2. When the software is loaded, a login dialog box will appear.  You must enter a username and 

password in order to gain access to the program. 
 
The default username is “admin”, with no password.  Type “admin” in the User Name field and press 
<ENTER>. 
 

3. Once you have reached the System Manager screen, select the correct system and double-click to 
enter the Display Manager. 
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Figure 12-7: System Manager 

 
4. Connect to the system by clicking the connect button in the toolbar (looks like a plug), and then select 

the correct output display that will have the input source that requires Closed Captioning Decoding. 
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Figure 12-8: Display Manager 

 
5. Select the window (video input) that will be used for Closed Captioning Decode. 
 
6. Click on the Properties box. 
 
7. Expand the Appearance heading. 
 
8. Locate Auxiliary OSD, and click the check box to select (enable). 
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Figure 12-9: Properties > Appearance 

 
If closed captioning is present on the video source, then the closed captioning should now appear on the 
output of the MVP for the configured video source. If closed captioning / teletext is not decoded, verify the 
line number/page number and configure accordingly using VistaLINK® PRO. 
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13. CONFIGURING FONTS 

The MVP installer comes with a selection of predefined fonts.  If installed to the default location, these 
fonts can be found at: 
 

C:\\Program Files\Evertz\MVP\Resources\Fonts 
 
To configure fonts on the MVP: 
 
1. Using the System Manager, click the Configure Fonts button. 
 

 
 
2. In the window that appears, click on the browse button, and then navigate to the save location for 

fonts. 
 

 
 
3. When finished, you will send the fonts to the appropriate card. 

 
To send the fonts to a specific card, select the card in the Font Configuration window, and then click 
the Send Fonts to Selected Cards button. 
 
To send the fonts to all cards, do not select any card, and then click the Send Fonts to All Cards 
button. 
 

4. Reboot the display card. 
 
5. Open Maestro, and right click on the system.  From the menu that appears, choose Download 

System Configuration. 
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The fonts have now been successfully configured. 
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